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Wprowadzenie

Celem niniejszego poradnika jest ufatwienie procesu nauki programu MDT poprzez
przechodzenie krok po kroku przez wszystkie etapy danego projektu. Zagadnienia poruszane w tej
instrukcji sg szczegdétowo i doktadnie wyjasnione w Podreczniku (Reference manual). W tym poradniku
zaktadamy, ze program ZWCAD (na bazie tego programu bedg omawiane kolejne zagadnienia) oraz
naktadka TcpMDT zostaty zainstalowane poprawnie. Aby wyjasnienia byly bardziej zrozumiate, do
poradnika zostaty dofgczone zrzuty ekranu z programu ZWCAD+ 2015. W innych wersjach programu
poszczegdlne czynnosci omawiane w niniejszym poradniku sg bardzo zblizone.

W celu przedstawienia mozliwosci programu w pracy z matymi oraz duzymi projektami,
zostanie przedstawionych 10 przyktadowych ¢wiczer. Cwiczenia opieraja sie na plikach dofaczonych
do programu MDT. DomyslInie instalujg sie w folderze: C:\MDT7 Samples.

Wersja Standard

1. Pierwsza z lekcji zawiera niewielki zbiér punktéw pomiarowych (100 pkt), na ktérych
wykonywane bedg operacje zarzagdzania punktami oraz zmiany definicji linii.

2. W drugim przyktadzie wykonywane bedga operacje triangulacji, tworzenia warstwic, profili.

3. Trzecia lekcja wykorzystuje dane wykorzystywane w pierwszej lekcji, na ktérych zostang
wykorzystane procedury obliczania mas ziemnych dla metod profilowych oraz siatkowych.

Wersja Professional

4. W tym ¢wiczeniu postugujemy sie duzo wiekszym zbiorem danych (750 pkt), na ktérym
przeprowadza¢ bedziemy projektowanie niwelety, nachylen, dodatkowych dtugosci, przekroi
itp.

5. Po wykonaniu poprzedniego punktu, przejdziemy do zdefiniowania bardziej ztozonych
elementdéw, w ktérych wykorzystamy powierzchnie juz istniejgcej drogi.

6. W tym przykfadzie, tak jak w poprzednich, gtéwnym celem bedzie stworzenie projektu drogi,
ale tym razem nawierzchnia zostanie zbudowana w oparciu o informacje z planu rysunkowego.

7. W ten czesci przyjrzymy sie wszystkiemu co jest zwigzane z definiowaniem warstw powierzchni
i ich objetosci.

8. Kolejna lekcja dotyczy korzystania ze zmodyfikowanych operacje na terenie, obliczania
objetosci mas ziemnych, tyczenia oraz przeprowadzania realistycznych symulacji.

9. Tworzone jest podfoze i wykonywane sg roboty ziemne, gdy znane sg wysokosci lub punkty
styku z terenem (nawigzanie do rysowania bryt i renderowania)

10. Projektowana jest o$ drogi wykorzystujgc inne elementy takie jak proste, tuki, klotoidy, by
nastepnie méc wykorzystywac jg do dalszej pracy.

11. Praktyczne wykorzystywanie przeciec droég.

Modut Geodezyjny

12. Przyktad obrazujacy wykorzystanie topograficznego modelu terenu oraz konwersje pliku
pomiarowego z tachimetru (total station) wraz z obliczeniem wspoétrzednych.

13. Kolejny przyktad, w ktéorym uzywamy bardziej zaawansowanych metod obliczania
wspotrzednych z uzyciem ciggdw poligonowych oraz sieci geodezyjnych.

14. W tej czesci zajmiemy sie transformacjami wspotrzednych pomiedzy réznymi uktadami
odniesienia.
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Modut Obrazéw

15. Praktyczny przyktad obrazujacy najwazniejsze funkcje modutu obrazéw w programie MDT.
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CWiczenie 1 == Zarzadzanie punktami

Firma budowlana zleca wykonanie pomiaréw geodezyjnych na dziafce, gdzie planowane s3
roboty ziemne w celu wykonania parkingu oraz poprawienia powierzchni terenu w pdtnocno-
zachodniej czesci. W zwigzku z tym, projekt zawiera kolejne wypetnianie ziemig fragmentu dziatki z
nadmiaru zebranego w innych jej czesciach.

Na poczatku wykonywany jest pomiar geodezyjny terenu w jego oryginalnym ksztatcie przed
wykonaniem inwestycji. Uzyskujemy wykaz wspétrzednych w wyniku obliczen geodezyjnych
wykonanych za pomoca jakiegokolwiek, stosownego programu obliczeniowego.

Aby wygenerowac odpowiednie przekroje poprzeczne, ktdore zawierajg projekt wykonawczy,
cyfrowy model terenu jest wykonywany przy pomocy obiektéw rysunkowych (polilinii), tgczacych
punkty pomiarowe i linie nieciggtosci. Przekroje poprzeczne zostajg wykonane w podtuznej osi N-S,
ktéra ma identyczne parametry do tych z projektu, co 2 metry, by nastepnie poréwnac z projektowymi
przekrojami co 10 m. Ten proces spowoduje powstanie pliku z przekrojami poprzecznymi.

Na koncu, po pobraniu innego zestawu punktéw pomiarowych zmodyfikowanego terenu,
przekroje zostang wygenerowane ze zmodyfikowanego modelu terenu przy uzyciu tej samej osi N-S.
Wtedy bedzie mozliwe obliczenie robot ziemnych.

Proces ten opisany jest krok po kroku w niniejszym éwiczeniu.

Uruchomienie programu

Prosze uruchomi¢ ikone MDT V7 zlokalizowang na pulpicie lub w Menu Start. Po wigczeniu,
uruchomiony zostanie odpowiedni program CAD wraz z naktadkg MDT V7.

Tworzenie projektu

Tworzac nowy projekt za pomocg MDT mamy mozliwos¢ lepszego zarzadzania elementami,
ktére sg generowane przez naktadke (np. powierzchnie, osie drdg itp.). Prosze uruchomi¢ MDT ->
Project -> New. Program poprosi o nazwe dla nowego projektu, prosze wpisaé Tutoriall w lokalizacji
C:\MDT7 Samples\Tutorial01. Po wykonaniu tych czynnosci, na ekranie pojawi sie ponizszy panel.
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Import punktéw

Project - tutoriall

]

' Drawings
=} Foirts

%5 Surfaces

"\, AMigrments
Y Profiles

¢ Grade Lines
w Sections

{5 Gnds
o Segments

{ General || Segments
Description

T+ Cross-sections

2 Superelevations
== Additional Widths

| Surfaces |

Hide

Prace z programem zaczynamy posiadajgc wykaz wspotrzednych wygenerowany przez
program geodezyjny. Punkty te mogg zosta¢ wprowadzone recznie lub zaimportowane bezposrednio
do programu. W naszym przypadku punkty znajdujg sie w pliku DEMO1.pun i zawiera 101 punktéw.
Ponizszy wykaz jest tylko fragmentem wspomnianego pliku, lecz mozna zauwazy¢ czego dotycza
poszczegdlne kolumny: Numer punktu, Wspétrzedna X, Wspétrzedna Y, Wspétrzedna Z, Kod.

2 257.8B36

3 258.914

5 260.736

6 262.893

8 265,817

9 270,104
10 272,797
11 278,382
12 282,897
14 284,979
15 285,349
l6e 287.658
17 292,947
18 296,339
19 296,223
20 284,724
21 286,749
22 291.682
23 295,453
2 288,523

.
|

-3 o
Ul e

SIS K]

O o0

FU Y N SN
. e

s WD W -

W B WD

=y

301.429
311.112
315.505
323.371
331 .671
338.837
346.624
346,885
347,153
347.070
353,138
73.268
372.258
372.405
368.948
343,006

o

o

.

o=

.

SN SN N
-1 =1
P

N
W Wy
D <

=y
|

7.560

7.850
48,180
49,050
49.700
50.290
50.910
51.140
51,120
51.120
51.120
52.160

51.240

Niektore punkty bylty kodowane w terenie,

dlatego

wygenerowad
zakodowanych punktéw. Relacje pomiedzy
kodami, a ich reprezentacjg graficzng w
ALB programie sg przedstawione w bazie danych

ALB T

ALB

ALB Points -> Codes -> Code Database. Widok
CMI bazy danych pokazano

ALB T

program moze
prezentacje

automatycznie

51.120 ALB
51.120 ALB
50.600 AES I
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Code Database [
Code Laval Type Layer Color Thickness  Blament
ALIGN Irfieematicn Line ALIGNMENT 7 Defauk  ACAD_|S002W100
CcP Break Line cP 5 Defauk ACAD_|S003W100
CT Break Line cT 2 Defauk  ACAD_|SO04W100
ELEC Al Point ELECTRIC_LINE 4  Defauk Transform
EXP Break Line EXP 6 Defouk  ACAD_ISO05W100
HS Break Line HIGH_SLOPE 4  Defauk Contiruous
LS Break Line LOW_SLOPE [ Defauh  Contiruous
PATH Break Line PATH 7  Defauk Continuous
PT Al Paint PT 2  Defauk Poia
RLL Break Line ROAD_LINE & Defaukt  Continuous
RLR Defaut Line ROAD_LINE 2 Defouk  Continucus
SHL Bresk Line SHOULDER 7 Defsu  Contiruous
TREE Al Paint TREES 3 Defauk  Tree
WALL Break Line WALL 1 Defaul Continucus

oK | [ Em et | [ Delete | [ Pt | [ Cancel | [ Heb

W celu zaimportowania punktéw prosze wybraé¢ Points -> Import. Nalezy wybrac¢ format
Generic oraz NXYZ. Separatorem powinna by¢ spacja (tak jak w pliku ze wspétrzednymi). Prosze
zaznaczyc¢ Classify Points by Level oraz Draw from Codes i wybrac skale 500.

(Import Points ilw
Format
Manufacturer Configuration
@ Generic |NXYZ =
Pessonal Configuratio
Operation Separator
" insent tial b D |¥] Space
9 Replace [] Comma
Merge [ Tabulator
Options
/| Test repetitions V] View repeated points
] Classify Points by Levels Level 1-Fa |
Representation
V| Draw Pointts [ Attributes | Layer [PONTS ] u
Text Height fmem) [o7s Scale (500 -|
| Draw from Codes ¥| Zoom in on point cloud
(oK) [Comcs | [ Hew.]
\ J

Nacisnij OK, nastepnie wybierz plik do importu Demol.pun, ktéry znajduje sie w folderze
C:\MDT7 Samples\Tutorial01. Punkty powinny zosta¢ zaimportowane i wyswietlone na ekranie.
Polilinie i bloki zostang rowniez narysowane w nawigzaniu do kodéw przypisanych do poszczegdlnych
punktow. Prosze sprawdzié¢ warstwy, ktére sie automatycznie utworzyty.

TcpMDT ver. 7 — Podrecznik uzytkownika
Ustugi Informatyczne SZANSA Spoétka z o.0. z siedzibg w Bielsku-Biatej przy ul. Chryzantemowej 5, 43-300 Bielsko-Biata zarejestrowana w Sadzie Rejonowym w
Bielsku-Biatej, VIII Wydziat Gospodarczy Krajowego Rejestru Sadowego pod numerem KRS 0000536210, z kapitatem zaktadowym 50.000 ztotych. NIP
9372672769, REGON 360604756. Wszystkie prawa zastrzezone.



4 ZWCAD+ 2015 Pro - [Rysunekl.dwg]

E Pk Edyca Widok Wstaw Format Narzedzia Rysuj Wymiar Zmied Narzedzia Dodatkowe Okno Pomoc MDT7
PEE R (XHHE - ORE %Y EED 0| Alsee [+ /1[s02 |+ B[ standard ~|| /7 standard -]
&[¢ &0 mreEs r& 2 & | [@staye Rl Bylayer |+ Bylayer |~ SINE(E L

+RROLMNEILOLADSE| F LK BEL A ITRRNESR T NEHBEE Q0 W

75
"
G b4 A
2 =) =je Points g
( <4 Demo &
i 3 Sufaces H
*},, Alignments

fY Profies ‘%’

2 Cross-sections ~

o Grade Lines ]

A C Superslevations -
== Widenings =
< H Templates e/
& ) Grids -
= o Seaments i
G @27 UNKNOWN O
Iy (]
B 9
© a
&= ¢
=] &
r‘._]

 [ow—— e a

General | Seaments | Sufaces
Description &l

4 4 b ¥\ Model { Arkusz1 } As

* Polecenie: Anuluj!
Polecenie: Anuluj!
Polecenie: '_.zoom _e

Polecenie:

359.9261, 287.4849, 0.0000 HHE L GO LR = [l

W celu sprawdzenia zaimportowanych danych prosze wybra¢ Points -> List Points (lub na
wstazce Points -> Operations -> List).

Points Selection X

Options

Level ...

Code ...

Heights ...

Numbers ...

Layer ...

Polyline (Area) <

Polyline (Longitudinal) <

\
\
\
\
‘ Group ..
\
\
\
\
l

|
|
|
|
|
Graphic < [
|
|
|
|

Extra attribute...

[ Delete Selection ‘ ‘ Invert Selection ‘

\ Al |
101 points selected of 101 available
[ ok | [ Camed | [ Heb. |

Wykorzystujgc powyzszy ekran systemu wyboru elementdw, klikngé All. Pojawi sie tabelka z
wszystkimi punktami zaimportowanymi do programu. Zawarte sg tutaj takie informacje jak: Numer
punktu, Wspodtrzedne X,Y,Z, warstwa, na ktérej lezy punkt, kod i ewentualny opis dodatkowy.
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List Points
Name T Level ¥ Coordnate | ¥ Coordnate | Z Coordinate Code Description in C Database =

Ell 2 Break 3nzan 221,70 47.820 RLL Road Line Left

|92 1Fil 295734 360853 50300 BMU S

93 2Bresk 297 657 368.757 50.250 LSS Lowest poirt of Slope

|94 1 Fil 296.410 353057 50.250 BMU

(%5 2Break 297.750 353037 50.250 LS Lowest point of Slope

|98 1Fil 295 545 346,046 50.250 BMU

‘97 2Break 297.423 346773 50.250 LS Lowest poirt of Slope

|98 1 Fil 292 898 346576 48830 BMU

9 1Fil 267 427 346773 50540 BMU L

| 100 2 Bresk 308060 a0z 52810 RLR S Foad Line Right

i 1o 2 Break 307302 356.261 52240 RLR Road Line Right >
« m b

ok | [ Lecae | | Dewe | [ E&t | | Rin. | [ Hep

Mozna zauwazy¢, ze pojawity sie 3 typy warstw do ktérych zostaty przypisane punkty: Break,
Fill, Information.

Zmiana symboli

Jedna z mozliwosci programu jest wyswietlanie kazdego punktu w inny sposéb w zaleznosci od
warstwy lub grupy, do ktérej nalezy. Prosze wejsé Points -> Change -> Change format (lub na wstazce
Points -> Operations -> Edit -> Change -> Change format). Nastepnie zaznaczamy As per levels oraz
All.

& s perevels! e

As per groups [
Points to be modfied
A
| Selection

Lok ] [Cmod ] [.bew. ]

Prosze nacisnac ... (trzy kropki). Pojawi sie kolejne okno, w ktéorym mozemy zmienic¢ parametry
wyswietlania punktéw w zaleznosci od warstwy, na ktorej leza.

J Keep draweng scale

Pt - -
! Dezwin 3D ) I~ Decmales ar Coty -
| Zal] Seale
Size 0290 e
Open hle.

Color o) :D -$— B B Savo fie

B Laye o|og4 =@ Desigrate <
Aues
Mame  Visib TextHegh \Width | Aegle  Hor Sefllp | VerSetlls | Justficatio Color | Shyie
Hame ¥ om0 1000 £.000 1000 1000 et ] NOT_Pust
Hesght F om0 1.000 1.000 0500 Left MOT_Purt
Code r om0 1 000 1.000 -2.000 Leit I o P

ok | | Cees | [ Hep

Zmienmy ilos¢ miejsc po przecinku na 3 (Decimals in Height) oraz zaznaczmy Draw in 3D.

TcpMDT ver. 7 — Podrecznik uzytkownika
Ustugi Informatyczne SZANSA Spoétka z o.0. z siedzibg w Bielsku-Biatej przy ul. Chryzantemowej 5, 43-300 Bielsko-Biata zarejestrowana w Sadzie Rejonowym w
Bielsku-Biatej, VIII Wydziat Gospodarczy Krajowego Rejestru Sadowego pod numerem KRS 0000536210, z kapitatem zaktadowym 50.000 ztotych. NIP
9372672769, REGON 360604756. Wszystkie prawa zastrzezone.



Definicja linii nieciggtosci

W zwigzku ze specyfikg wykonywania pomiaréw terenowych, jest niemalze niemozliwe, aby
moc zakodowaé wszystkie punkty w odpowiedniej kolejnosci. Aby nie komplikowac¢ procesu
pomiarowego, pewne problemy mozna rozwigzad juz na etapie pracy w programie MDT.

Na poczatku zostanie stworzona linia o statej dtugosci, ktéra ma tylko jedng pomierzong
strone. Prosze wybrac Break Lines -> Displaced Parallel (lub na wstgzce Break Lines -> Creation ->
Displaced Parallel). Wybraé Points, a w miejscu Layer wpisa¢ PATH. Zaznaczy¢ Create Points i w
miejscu obok wpisa¢ PATH. Na koricu w sekcji Heights wybra¢ opcje Repeat i nacisng¢ OK.

Displaced Parallel =
Mode

@ Foirts
Pobline
Optiors
| Create Points Level g Dedmid -

Code PATH] Seect

Constart
Variable (Manual)

Varable jpont Codes)

ok | Cancel Felp ...

W wierszu polecen pojawito sie First Point. Prosze teraz myszkg kolejno wybiera¢ punkty o
numerach 112, 2,3,5, 6, 8,9, 10, 11, 12, 14, 15 i 20 w przedstawione] kolejnosci. Jesli pomylimy sie
przy wyborze punktéw, mozna nacisng¢ ,U”, co cofnie wprowadzanie poprzedniego odcinka. Po
ostatnim punkcie naciskamy ENTER. Teraz program wymaga orientacji, prosze nacisngé na lewo od
wskazywanej linii. Teraz nalezy wpisa¢ o ile ma odsuna¢ sie nowa linia od istniejgcej, wpisujemy 5 i
zatwierdzamy ENTER.
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Pojawita sie nowa linia na warstwie PATH odsunieta o 5 m od istniejgcej. Utworzone zostaty
rowniez punkty na przecieciach segmentow, ktérych wysokosci odpowiadajg wysokoscig punktéw na
linii oryginalnej.

W podobny sposdb mozemy dokoriczy¢ manualnie linie stanowigca dolny fragment muru
nalezacy do stawu. Prosze wybraé Break Lines -> Point Numbers (lub na wstgice Break Lines ->
Creation -> Numbers). Zamiast wybierac istniejgcg warstwe, utworzona zostanie nowa. Nacisnij New.

Prosze wpisa¢ LOW_WALL jako nazwe warstwy, wybraé czerwony kolor i wcisngé OK.

Enter Mew Layer
Nama LOW_WALL

Color B -
LineTyoe | Continuous =

[ os Cancel Helo

Prosze wpisac nastepujacg kombinacje punktow:

t: 99 <Enter>
e t: 21 <Enter>
Cther point: <Enter>
First point: 92 <Enter>
Other point: 22 <Enter>
Cther point: <Enter>

First point: <Enter>
Command :

Prosze powtdrzy¢ cata procedure tworzac nowa warstwe HIGH_WALL, wybierajgc niebieski
kolor oraz wprowadzajgc nastepujacg kombinacje:

99 <Enter>
24 <Enter>
Other t: <Enter>

First point: 28 <Enter>
Other point: 12 <Enter>

Other point:

iLer>

First point: <Enter>
Command:

Na koniec powtdérzmy jeszcze raz catg procedure, lecz tym razem wybierajagc warstwe
LOW_SLOPE. Prosze pofaczy¢ punkty 97, 29, 48 oraz 97,98.

Rysunek jest juz gotowy, prosze zapisa¢ go jako demol.dwg w katalogu z projektem. Gdy
projekt jest otwarty, program zapyta, czy zyczymy sobie dodad rysunek do projektu, co potwierdzamy.
Tres¢ komunikatu moze wyskoczy¢ w jezyku hiszpanskim, lecz nie jest to btad. Nalezy nacisng¢ przycisk
po lewej stronie.
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CWiczenie 2 = Warstwice oraz profile

Na tym etapie proces powstawania planu jest gotowy. Mozina przystgpi¢ do tworzenia
Numerycznego Modelu Terenu (NMT lub DTM).

Prosze otworzy¢ rysunek DEMO2.dwg zlokalizowane w folderze Tutorial2.

Tworzenie projektu

Tworzac nowy projekt za pomocg MDT mamy mozliwos¢ lepszego zarzadzania elementami,
ktore sg generowane przez naktadke (np. powierzchnie, osie drég itp.). Prosze uruchomi¢ MDT ->
Project -> New. Program poprosi o nazwe dla nowego projektu, prosze wpisa¢ Tutorial2 w lokalizacji

C:\MDT7 Samples\Tutorial02.

Tworzenie powierzchni

Prosze wybra¢ Surfaces -> Create Surface (lub na wstazce Surfaces -> Creation -> Create
Surface) lub w oknie projektu naci$nij prawym klawiszem myszy na Surfaces i nastepnie Create
Surface. Wybieramy Demo2.sup i zapisujemy w gtéwnym katalogu z projektem. Aktywujemy Points,
Break Lines i Boundary Line. W sekcji Representation wybieramy Complete.

Create Surface
Cument Surface
CA \Bemph 02\Dema 2 SUP
Bements to Trianguiate
| Points |

P -

o | Break Lines [

[7] Comours

Window

+ | Boundary Line

lelands

¥ include 30 Break Line Vertices
Discretize Arcs of Break Lines

Fepresentation
Nothing Layer
Cuick View J| Clear Layer
Boundary Bolatle Layer
Window
@ Complete Draw in 3D
Configuration,
oK | | Cencd |

SRF-TRIANGULATION | [ .

| Zoom to surface
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Aby zdefiniowaé, ktére warstwy zawieraja linie nieciggtosci, klikamy Layers obok Break Lines.
Aby wybra¢ poprzednio zapisane warstwy, kliknij Load i wybierz Demo2.cap lub recznie wybierz
warstwy do zaznaczenia.

Luwan Avmlabis

Klikniecie rozpocznie proces triangulacji, ktory weZzmie pod uwage réwniez linie nieciggtosci,
ktore wczesniej zdefiniowalismy. Po wykonaniu triangulacji, powierzchnia doda sie automatycznie do
okna projektu.

Edycja triangulacji

Mozliwa jest reczna modyfikacja przebiegu bokéw tréjkatéw. Aby jej dokonac nalezy wejs¢ w
Points -> Locate Point (lub na wstazce Points -> Operations -> Locate) i wpisa¢ 32 (numer punktu) i
wpisa¢ margines poszukiwan 20.

Obserwujac relacje punktu 46 oraz 32 mozna dojs¢ do wniosku, ze aby lepiej odwzorowac
teren mozna by potgczy¢ punkty 45 i 31 zamiast obecnych. WejdZzmy w Surfaces -> Insert Line (lub na
wstazce Surfaces -> Edit -> Insert Line) | graficznie potgczmy punkty 45 | 31.
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Szybki profil

W tej czesci ¢wiczenia przystagpimy do tworzenia profilu podiuznego oraz przekrojow
poprzecznych. Aby tego dokonaé prosze wejs¢ w MDT7 -> Quick Profile. Teraz nalezy wybrac linie
przekrojowa, wzdtuz ktérej zostanie wygenerowany nasz przekrdj. Wybierzmy pierwszy punkt
znajdujacy sie w centralnej czesci rysunku na zachdd, a drugi punkt wybierzmy tez w centralnej czesci
na wschodzie. Powinnismy otrzymacé cos zblizonego do profilu prezentowanego ponizej. Mozemy
oczywiscie modyfikowac opcje znajdujgce sie w oknie z profilem i obserwowac jednoczesnie jak profil
sie zmienia.

Quick Profile -

Sepaaton )

Hormoedal |5 Statioec 0350 Hesghtt 51828
Packin Slopes

Save Apeiage

i

Dt Align Maimrn BTG Find Heght 50,080 Misaeas

Vatical Facts |4

Indal Hegrt 47730 M [ 54110

|

Generowanie warstwic
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Aby stworzy¢ warstwice na podstawie NMT musimy przejs¢ do Contours -> Contours (lub na
wstazce Contours -> Drawing -> Contours) lub uzy¢ opcji Draw Contours po kliknieciu prawym
klawiszem myszy na naszg powierzchnie w oknie projektu.

Skala rysunku oraz rdéznice wysokosci miedzy punktami sugerujg, aby wykonaé ciecie
warstwicowe co 0.5 metra. Zmodyfikujmy pozycje Minor (Interval) i wprowadZmy tam 0.5, w tym
czasie automatycznie ulegnie zmianie pozycja Major na 2.5 (jako, ze 0.5x5 = 2.5). Wygtadzanie jest
domyslnie ustawione na 0, aby nie przetadowywal niepotrzebnie rysunku. Wygtadzenie mozna
rowniez pdzniej zastosowad na wygenerowanych warstwicach.

Contour Line Gener;hcm‘ ‘ = M

C:\ A\ Tutoral 02 Demo 2 SUP

CV-MINOR

Mapr  [CV-MAIOR

Ulsar Layss

Heighls Irtervals

Wremum 45030 ] Mnar

Mapamum 52810 | Major

Dz a2
@ Polylines Contours

Smoathing factor

Nacisnij OK, aby rozpocza¢.
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Teraz przyjrzyjmy sie powstatym warstwicom, aby odkry¢, czy nie powstat jakies niepokojgce
deformacje. Przyjrzyjmy sie obszarowi w rejonie punktu 27. Points -> Locate Point (lub na wstgzce
Points -> Operations -> Locate).

Mozna dojs¢ do wniosku, ze warstwice ponizej punktu 27 sg w sposdb sztuczny sttoczone przed
linig t3czaca punkty 30 oraz 29. Mozna to naprawi¢ wstawiajac linie triangulacyjng miedzy punktami
31 i 48. Aby to zrobi¢ nalezy wejs¢ w Surface -> Insert Line (lub na wstazce Surface -> Edit -> Insert
Line) i potgczy¢ punkt 31 oraz 48. Zwré¢ uwage jak linia triangulacyjna oraz warstwica zmieniaja sie
automatycznie.

Tworzenie opisu warstwic

Jesli warstwice wygladajg juz dobrze, rysunek moze zosta¢ dokonczony poprzez stworzenie
opisu warstwic, wygtadzenie i wprowadzenie wyinterpolowanych wysokosci. Na poczatku ukryjmy
warstwe z trdjkgtami (SRF-TRIANGULATION) poprzez nacisniecie ikony latarki na liscie wszystkich
warstw (podobnie jak w AutoCad). Nastepnie wybierzmy Contours -> Labelling (lub na wstgice
Contours -> Drawing -> Label). Pojawi sie nastepujace okno:

Tetstie  [CVETIQUETAS = [l
Text Height fnm) 1500 Number of decimals 2 v
Contours
J Layers... | Cv-MASTERS
Automatic .. | Marua | Dvrecton Lines
| Cancel Help ..

Skoro mamy warstwice co 0.5 m to dobrze by byto ustawi¢ 2 miejsca po przecinku w Number
of decimals i Text Height ustawic na 1.5. Prosze wybraé Automatic.
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Jak mozna zauwazy¢, podpisy warstwic utworzyty sie na granicy obszaru. Mozna oczywiscie
umiesci¢ podpisy tam, gdzie sie tego oczekuje, w tym celu musimy jeszcze raz wejs¢ w Contours ->
Labelling. Tym razem naciskamy Manual, pojawi sie kwadracik do zaznaczania elementéw zamiast
typowego kursora i proszeni jesteSmy o nacisniecie warstwicy, na ktérej chcemy zrobi¢ opis.

Aby nie doprowadza¢ do naktadania sie opisdw na siebie i sprawiania, ze obraz stanie sie
nieczytelny, mozna wprowadzi¢ dodatkowe, punktowe wysokosci w dowolnym miejscu na mapie.
Punkty te powstang z interpolacji. Prosze wybraé Contours -> Place Heights Lables (lub na wstgzce
Contours -> Drawing -> Place Heights). Ustawmy tutaj ilos¢ miejsc po przecinku na 3 | 1.5 jako
wysokos¢ tekstu oraz O jako Label Angle. Naciskamy OK, i nastepnie program zapyta nas o to, gdzie

wstawié punkt.
Point: 279.71,238.32 <Enter>

Height <45.2Z266>: <Enter>

point: (Give some location for text)

t in
Faoint:

Najpierw wpisujemy wspotrzedne, pdzniej zatwierdzamy wysokos$¢ podang przez program (lub
wpisujemy inng), nastepnie wskazujemy gdzie ma znajdowac sie opis punktu oraz zatwierdzamy
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enterem lub wprowadzamy kolejny punkt. Mozliwe jest rowniez wskazywanie graficzne miejsca, w
ktérym wstawimy punkt wysokosciowy.

Na koniec wygtadzimy warstwice, ktére wcigz pozostajg kanciaste, jako, ze nie wybraliSmy opcji
wygtadzania na samym poczatku podczas tworzenia warstwic. Wybierzmy Contours -> Smoothing (lub
na wstgzce Contours -> Edit -> Smoothing). Ustawmy Smoothing Factor na 3 | nacisnijmy OK.

o SreaOleng Pt

Diplioass

bl

Nie zapomnijmy zapisac rysunku.
Definiowanie osi drogi

Aby zdefiniowad o$ drogi, prosze wejs¢ Alignments -> Draw alighment.

Draw origin of <Straight line>/Curve/Input clothoid: 293.60, 346.90 <Enter>

Draw the azimuth of <5t

raight line>/Curve/Input clothoid: 276.7734,287.227 <Enter>
Po wpisaniu powyzszych danych, pojawi sie okno:
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2174971

l_* non
UL U

[: 000

(62.000
[ Do not show this window

ok 1 | Cancel |

W oknie tym zaznaczmy Do not show this window, aby wykonywac¢ operacje na wierszu
polecen. Wpisujemy dalej

Draw the final peint of <Curve>/Straight line/Input clothoid/Check(Yes) /Delete/Terminate: 276.7101,
276.6008 <Enter>

Draw the final point of <Straight line>/Curve/Input clothoid/Output clothoid/Check (Yes)/Delete/Terminate:
286.84660.238.9412 <Enter>

We then press <Enter> again to complete the alignment data input.

Gdy nacisniemy Enter, pojawi sie nastepujgce okno:

Name |Aigrment]

Station [0.000 | Length: 111755
Instruction

Speed (Km/h)
Category [ Group i Aoad 80, 60 and 40

[7] Bxport to file
|| Dimension Alignment

[ ok

W biezgcym oknie wybierzmy Kategorie tak jak na rysunku oraz wpisa¢ nazwe dla naszej osi
drogi np. DEMO2. Zaznaczmy tez opcje Export to file, aby mie¢ mozliwos¢ zapisania osi drogi do pliku.
Pojawi sie ostatnie okno, w ktérym zaznaczmy skale 1:500 i nacisnijmy OK.

Dimensioning Alignments

Dimensioning

Short Mark Interval [10000 ] [ Options... |
Long Mark Interval
[ Unique Points

[ Invert Vertically
[] Intersection Points

[ Specfied station

Scale | EXTINN | - | Text Height

ALIGNMENT-DIMENSION
Shyle... STANDARD
[ ok ] [ caneal | [ Hep

0Os$ drogi pojawi sie automatycznie na rysunku.
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Aby uzyskac wiecej informacji o danej osi drogi, wybierzmy Alignment -> List Alignment (lub
na wstgzce Alignment -> Edit -> List). Wybierzmy nasza o$ drogi, po czym pojawi sie tabela z
elementami naszej osi drogi wraz z ich parametrami.

Alhgrvrmt
80.000
Givoup B Foad B0, 60 and 40

¥ Coord
45,300
;|
26m
23| 1832613

Fladus Farameier Lengin
0.000 000 62000
21000 0000 1075

0000 0.000 9,000

0K Prire, Export. Help

Aby zakonczy¢ tworzenie osi drogi, zapiszmy jg do pliku. W tym celu wybierzmy Alignment ->
Export alignment (lub na wstgzce Alignment -> Utilities -> Export). Wybierzmy nasza linie kursorem,
w wyskakujgcym oknie nacisnijmy OK bez wprowadzania dodatkowych zmian, a nastepnie nazwijmy
naszg linie np. DEMO2.eje. Od tego momentu nazwa ta bedzie wyswietlana w oknie projektu.

Tworzenie przekrojow poprzecznych

Aby stworzy¢ automatycznie przekroje poprzeczne wybierzmy Cross Sections -> Get Cross
Section (lub na wstazce Cross Sections -> Creation -> Get Cross Sections), a nastepnie wskazujemy,
ktorej osi drogi bedzie to dotyczyto.

MDT wybrato powierzchnie na bazie ktdrej bedzie tworzyto przekroje (u nas jest to
Demo2.sup), jesli mamy w projekcie wiecej powierzchni, mozemy wybra¢ w tym miejscu odpowiednia.
Automatycznie tworzy sie nazwa dla pliku z przekrojami poprzecznymi (Demo2.tra). Nastepnie
okreslamy jaka ma by¢ szerokos¢ naszego przekroju liczgc od linii pomiarowej. Wpiszmy w sekcji Profile
Length (m) dla Left oraz Right 40 m. Zaznaczmy réwniez opcje Unique Points, natomiast w polu
Interval wpiszmy 2, dzieki czemu profile poprzeczny uzyskamy co 2 metry. Klikamy OK, w nastepnym
oknie réwniez OK oraz klikamy w dowolnym miejscu arkuszu, gdzie majg sie wygenerowac nasze
przekroje (polecamy rysunek miec¢ po lewej stronie, gdyz, jesli przekrojow bedzie duzo, mogg one
wygenerowac sie na naszym rysunku).

Program umozliwia sprawdzenie przekrojéw na ekranie. Ta opcja jest dostepna po wejsciu
Cross Sections -> Edit Cross Sections (lub na wstgzce Cross Sections -> Edit). Wybieramy Demo2.TRA,
po czym program powinien wysrodkowacd przekréj na catym ekranie. Aby przesuwad sie po kolejnych
przekrojach nalezy nacisngé Next lub Previous (czarne strzatki na gédrnym pasku).
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Pozyskiwanie profilu podtuznego

W tej czesci podrecznika doprowadzimy do uzyskania profilu podtuznego dla naszej osi drogi.
W tym celu musimy wejs¢ w Profiles -> Get Profile i graficznie wybierzmy nasza linie. Pojawi sie okno,
w ktdrym mozemy modyfikowac parametry przysztego profilu.

Suface CAMDT? Samples'\Ejemplo 2\ Resutados'\Demo 2 SUP
Fie CAMDTY Samples'Bemplo(2\Resultados \demo2 LON
Source Configuration
Samping
Intial Station 0.000
4 Al Cuts
| Exdend Profile
7| Drarer Profie | Unique Pointa
Fiter Destances
Station Limis
J rterval 100
Deresction
Heght Limits & Direct
Irnvarss
QK Cancel Help

Program automatycznie wybrat powierzchnie Demo2.sup, tak jak przy przekrojach
poprzecznych. Ponizej widzimy propozycje nazwy dla naszego profilu — Demo2.lon. Wybierzmy opcje
All cuts, Unique points oraz Draw profile. Po kliknieciu OK pojawi sie kolejne okno z mozliwoscig
zmiany parametrow graficznych samego profilu. Naciskamy OK. Wybieramy miejsce, gdzie ma pojawic
sie nasz profil i klikamy myszka. Profil zostanie wygenerowany automatycznie.
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Modyfikacja profilu

Wykonamy teraz modyfikacje na samej osi drogi i bedziemy obserwowali jakie zmiany zajdg na
samym profilu podtuznym. Wybierzmy Alignments -> Edit Vertex -> Edit Vertex. Graficznie
wskazujemy na tuk miedzy dwiema prostymi na naszej linii pomiarowej. Pojawi sie ponizsze okno, w
ktérym zmienimy parametr Radius w naszej krzywej na -90. Zwiekszy sie promien tuku naszej linii, co
spowoduje zmiane jej przebiegu.

Edit Alignment ‘ ﬁ

|
| Previous Straight Length: 42.711 '

Lead-in Clothoid

Parameter  0.000 | Length [0.000
Curve

Radius [90.000 Length  [48.400
Spiral Out

Parameter 0.000 Length  |0.000

Next Straight Length: 19.711

Instruction Parameters

OK | [ Cancel | [ Hep..

Nasza linia pomiarowa zostata juz zmodyfikowana, lecz zmian nie widac jeszcze na profilu, w
tym celu musimy go fizycznie zaktualizowa¢. Aby tego dokona¢ wchodzimy w Profiles -> Update
profile. Wybieramy graficznie nasz profil wskazujac go myszka, co spowoduje pojawienie sie
ponizszego okna.

TcpMDT ver. 7 — Podrecznik uzytkownika
Ustugi Informatyczne SZANSA Spoétka z o.0. z siedzibg w Bielsku-Biatej przy ul. Chryzantemowej 5, 43-300 Bielsko-Biata zarejestrowana w Sadzie Rejonowym w
Bielsku-Biatej, VIII Wydziat Gospodarczy Krajowego Rejestru Sadowego pod numerem KRS 0000536210, z kapitatem zaktadowym 50.000 ztotych. NIP
9372672769, REGON 360604756. Wszystkie prawa zastrzezone.



‘f Draming Algrment Project Alignmert
‘[ Intial Station 0.000 Initial Station 0.000
|  Final Station 110821 Final Station 111.756
\ Length 110.821 Length 111.756
'1 Update from._.
i @ Drawing Aligrnment
Project Alignment
m [0k ] [ cance [ Hep.. |

Wybierajac opcje Drawing Alignment dajemy informacje do programu, ze chcemy, aby
uaktualnit profil w oparciu o modyfikacje wykonane na rysunku, co tez uczyniliSmy modyfikujac
parametry naszej osi drogi.

[ HORZGHTAL —B0x

| Allghmentl
YERTIGAL =00

SCALES &0,00

*,C, 40,00

[T - Allgnmentl

SCALES
| vrmaw. =

P.C. 40,00

: @ 40,00

iz &

4

=5

Na pierwszy rzut oka nie ma widocznej réznicy miedzy gérnym profilem (przed modyfikacjg), a
dolnym, w ktérym dokonalismy zmian. Klucz tkwi w tym, ze zmianie ulegty wysokosci terenu, przez
ktore przechodzi nowa linia pomiarowa, a co za tym idzie zmianie ulegt sam profil. Na ponizszych
rysunkach wida¢ wysokosci przed i po modyfikacji z tego samego obszaru.
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Na koniec mozemy wprowadzi¢ dodatkowe informacje do profilu w postaci kilometrazu oraz
wysokosci. Aby tego dokonaé wchodzimy Profiles -> Draw Station and Elevation in the Profile. Pojawi
sie nowe okno, w ktérym ustawiamy opcje jak na ponizszym rysunku (zatwierdzamy ustawienia

domyslne) i naciskamy OK. Teraz mozemy nacisng¢ gdziekolwiek na profilu, aby program wstawit nam
opis oraz wysokos¢.

Labe! Points in Profile h ]

Direction
@ Horizontal Vertical

Parameters
| Label Prefix

Warto tutaj zaznaczy¢, ze optaca sie mie¢ wigczone opcje przyciggania do koncéw punktow,
gdyz program wstawi punkt tam, gdzie mu go wskazemy. Jesli okaze sie, ze nie trafimy np. w punkt na

profilu, to program poda kilometraz do tego punktu, po czym wyinterpoluje odpowiednio wysokos¢,
co nie zawsze jest efektem pozgdanym.
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CWiCZEh ie 3 = Obliczenia mas ziemnych

Metoda przekrojow poprzecznych

W tej czesci podrecznika zajmiemy sie obliczaniem mas ziemnych poprzez réznice miedzy
powierzchnig oryginalng, a zmodyfikowang za pomocg dwdch metod: metodg przekrojéw
poprzecznych oraz siatki grid.

Otwieramy rysunek surveylnitial.dwg, ktéry znajdziemy w folderze C:\MDT7
Samples\Tutorial03.

|||'|'|| I
(it
e

Musimy zaimportowa¢ naszg o$ drogi, ktéra znajduje sie w folderze z ¢éwiczeniem -
Alignmentl.eje. Aby to uczyni¢ musimy wejs¢ w Alignment -> Import Alignment (lub na wstazce
Alignment -> Drawing -> Import). Po zaimportowaniu tworzymy przekroje poprzeczne tak jak w
Cwiczeniu nr 2 w tym podreczniku. Przed naciénieciem OK nalezy wybra¢ jeszcze Source. Pojawi sie
nowe okno, w ktérym musimy zaznaczy¢ opcje Layers List, a nastepnie z listy ponizej wybraé warstwy
z naszymi warstwicami tj. CV-MASTERS i CV-NORMALS. Nastepnie w parametrach ustalamy szerokos¢
profilu z prawej oraz lewej strony na 50 oraz ustawiamy interwat 5. Naciskamy OK.
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Tutaj mamy juz zaimportowang os drogi. Wykonujemy przekroje poprzeczne tak samo jak dla
poprzedniego rysunku, z tym, ze tym razem w Source zaznaczamy opcje Digital Terrain Model.
Zaznaczamy oczywiscie naszg o$ drogi oraz wybieramy miejsce na przekrojow poprzecznych. Tak
naprawde najbardziej istotne sg tutaj dwa pliki surveylnitial.tra oraz surveyFinal.tra.
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Obliczanie objetosci

Wynik obliczenia objetosci mas ziemnych otrzymamy poprzez natozenie dwdch zestawow
przekrojéw poprzecznych na siebie. Zrobimy to poprzez wejscie w Volume -> Cross Section Difference
(lub na wstgzce Volume -> Dlifference Profiles). Pojawi sie okno wyboru zestawu przekrojow
poprzecznych, w ktérym musimy wybraé pierwszy zestaw stworzony z rysunku surveyinitial.dwg,
nastepnie wskazujemy plik stworzony na podstawie rysunku surveyFinal.dwg. Pojawi sie kolejne okno,
w ktdrym mozemy modyfikowa¢ parametry obliczenia objetosci przez program. Poczatkowy
kilometraz jest ustawiony na 0.000 jako, ze zaczynamy obliczenia od poczatku naszej osi drogi.
Wpiszmy grubosé warstwy ziemi na 0.3 w Soil Value.

Volumes by Profile Diferences ==
interval List Type Methods of Calculation
irial Station 0.000 Momal @ Ayerage Aeas
Final Station 421,056 @ Accumulated
Prsmatoids
Slopes
. Cunvabure Comection
o] Vertical
Slope parameten Valume multiphers
Custing 1.000
Fi [1.000 ]
Accumulated Violuma
Cufting 0.000 |
Parameters
- Fi 0.000 |
Oeganic Scil Thickness 0.3
Minimum Surface [o0an ] oOrgSal 0.000
Waiume intenvals
Lok | Cancel Felp

Naciskamy OK. Program przeliczy teraz objetosci i pokaze w kolejnym oknie czesciowe
sktadniki objetosci.
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Nacisnijmy Draw. Nastepnie wybierzmy w Paper Size opcje DIN-AO co odpowiada kartce
formatu AO. Prosze zaznaczy¢ opcje Model w sekcji Space, Horizontal Scale ustawi¢ na 500 i Vertical
Scale ustawi¢ na 500.
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Prosze jeszcze nacisngc przycisk Advanced. W nowym oknie wprowadZmy w sekcji Horizontal
Division wartos¢ 10, natomiast w Vertical Division 5.
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Naciskamy OK w dwdch kolejnych oknach. Na rysunku wybieramy miejsce do wygenerowania
nowych przekrojéw. Nowe przekroje bedg sktadaty sie z natozonych na siebie dwdch zestawow
przekrojow z obu rysunkéw Initial oraz Final.

Metoda rdoznicy siatki grid

W tej czesci wykonamy kolejne obliczenie objetosci mas ziemnych. Prosze ponownie
przefaczyc sie na rysunek surveylinitial.dwg. Nastepnie wchodzimy w Grids -> Create Grid from Surface
(lub na wstgzce Grids -> Creation -> Grid from Surface). Wybierzmy powierzchnie surveyinitial.sup.
Prosze wybra¢ Binary Grid oraz Cell size ustawié¢ na 1. Plik zapisa¢ jako surveyinitial. mde.

ASCH Gnd
@ Bnary Gnd

Cedl Size
Approxmate size: 127915 cels, 500 Kbytes

Boundary

Exdrapciate cells in penmeter

ok ] [ comel |
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Teraz wykonujemy te same operacje z rysunkiem surveyFinal doprowadzajgc do powstania
pliku surveyFinal. mde.

Nastepnie prosze wybra¢ Volumes -> Grid Difference (lub na wstazce Volumes -> Terrains ->
Difference Grids) | nacisngé¢ OK. Nastepnie wybieramy siatke grid Initial, a po niej siatke grid Final,
ktore utworzyliSmy wczesniej. Pojawi sie okno z wynikami obliczenia objetosci. Wybierzmy opcje Draw
volumes oraz Isolate Layer.

Cutt Viokume: 1161985

Fil Volume: 15870.454

Diference: -14708 465

Orgaric Sodl Vol 0.000

Cut Area T74.000

Fil Aea 5143.000

| Draw wolumes

Claar Layer Height [ifferances

Layer [VOLUMEGRAPHICS | [ Select
Color Paietie
O [ Select ]
i Select

(oK | [ conesl | Hep . |

MDT domyslnie ustawia palete koloréw na wartosci czerwone dla wykopdéw (cut) oraz
niebieskie dla nasypow (fill). Paleta domysina odwzorowuje stylistyke kolorystyczng czesto spotykang
w atlasach geograficznych.

Legend
Twtheght 100 ColSem 1

M Discanahi L

o ] Cancel

TcpMDT ver. 7 — Podrecznik uzytkownika
Ustugi Informatyczne SZANSA Spoétka z o.0. z siedzibg w Bielsku-Biatej przy ul. Chryzantemowej 5, 43-300 Bielsko-Biata zarejestrowana w Sadzie Rejonowym w

Bielsku-Biatej, VIII Wydziat Gospodarczy Krajowego Rejestru Sadowego pod numerem KRS 0000536210, z kapitatem zaktadowym 50.000 ztotych. NIP
9372672769, REGON 360604756. Wszystkie prawa zastrzezone.



Zestawienie utworzonych plikéw

Po zakonczeniu pracy, w folderze z projektem powinnismy otrzymadé nastepujace pliki.

Plik Opis

surveylnitial. DWG Oryginalny rysunek z pierwotnym terenem

surveyFinal. DWG Oryginalny rysunek ze zmodyfikowanym terenem

Alignment1.EJE Plik zawierajgcy o$ drogi

surveylnitial. SUP Plik zawierajgcy zapis powierzchni z rysunku z
pierwotnym terenem

surveyFinal.SUP Plik zawierajgcy zapis powierzchni z rysunku ze
zmodyfikowanym terenem

surveylnitial. TRA Plik zawierajgcy zestaw przekrojow poprzecznych
dla pierwotnego terenu

surveyFinal. TRA Plik zawierajgcy zestaw przekrojéw poprzecznych
dla zmodyfikowanego terenu

surveylnitial. MDE Plik zawierajacy siatke grid dla pierwotnego terenu

surveyFinal. MDE Plik zawierajacy siatke grid dla zmodyfikowanego
terenu
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CWiczenie 4 = Projektowanie drég

W tym ¢wiczeniu rozpoczniemy prace na pliku, w ktérym wykonana zostata juz triangulacja i
narysowane zostaty warstwice. Wykonamy zatem profil podtuiny oraz poprzeczne dla linii
pomiarowej, ktdra rowniez jest tutaj juz utworzona. Stworzymy rdéwniez miejsca poszerzen,
przechytek, i zdefiniujemy linie niwelety.

Uzyjemy ponadto narzedzi do tyczenia. Aby w petni zrozumie¢ wszystkie kroki przedstawione
w tym ¢wiczeniu zalecamy zaznajomienie sie z poprzednimi przyktadami zawartymi w tym poradniku.

Wybor projektu

Na poczatku otwdrzmy rysunek survey.dwg znajdujacy sie w folderze C:\MDT7
Samples\Tutorial04.

W oknie projektu wybieramy powierzchnie, naciskamy prawym klawiszem myszy i wybieramy
Set as current.
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Generowanie przechytek oraz poszerzen

Jesdli uzywamy AutoCad 2010 lub nowszego, aktywujmy wstgzke Segments, aby otrzymac
narzedzia do pracy na przechytkach oraz poszerzeniach.

Home Inset  Annotate  Parametric  View Manage Output Add-ins  Autodesk 360  ExpressTools EIM360  Featured Apps  MDT7 -

4 ‘¢ #i4 3D Polyline r" ~ .~ From Alignment C X Table == v
i -ty :

' % Blocks o £ From profile d % g .
Define/Edit Check Draw Draw : Alignment  Check * Generate MDT7 Close
nstruye Interseccién | Profile Cross-Section # To 30 polyline N N =
Creation Drawing Superelevations Additional Widths  Utilities

Aby wygenerowal przechytki zwigzane z nasza osig drogi musimy wejs¢ Segments ->
Superelevations -> Generate Superelevations from Alignment (lub na wstaice Segments ->
Superelevation -> Alignment -> Alignment). Wybierzmy nasza o$ drogi, po czym pojawi sie nowe okno.
Wybierzmy w nim drugg kategorie jak na rysunku ponizej i nacisnijmy OK.

Speed (Km/h)

Cateaoy | Group Ii- Road 80, 60 and 40

Cancel

Aby zwizualizowa¢, co zostato utworzone wejdZzmy w Segments -> Superelevation -> Chceck
Superelevation (lub na wstgzce Segments -> Superelevation -> Check) i wybierzmy plik do
sprawdzenia — czyli to co wygenerowalismy chwile temu.
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Pozyskanie profilu podtuznego

Podobnie jak w poprzednich éwiczeniach, profil uzyskujemy poprzez wejscie w Profiles -> Get
Profile (lub na wstgzce Profiles -> Creation -> Get Profile). Prosze aktywowac¢ opcje All Cuts, Unique
Points, natomiast nalezy odznaczy¢ opcje Interval. Naciskamy OK.

Fie | CAMDTT Projects’ Tutosal 14" survey LON
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Profil podtuzny moze zosta¢ réwniez zwizualizowany po naci$nieciu w oknie projektu prawym
klawiszem myszy i wybraniu opcji Check (lub na wstgzce Profiles -> Edit -> Check Profile).
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Nastepnie wybieramy narzedzie Profiles -> Draw Simple Profile (lub na wstgzce Profiles ->
Drawing -> Draw Simple Profile) i wybierzmy plik z naszym profilem. Ustawiamy nastepujgce opcje:
Paper Space, rozmiar strony na DIN-A3, Horizontal Scale 1000, Vertical Scale 200, Constant Interval
10. Klikamy OK.
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Pozyskiwanie przekrojow poprzecznych

Podobnie jak poprzednio, aby otrzymac przekroje poprzeczne nalezy wejs¢ w Cross Sections -
> Get Cross Sections (lub na wstgzce Cross Sections -> Creation -> Get Cross Sections). Domyslnie plik
z przekrojami zostanie zapisany jako survey.tra w folderze z projektem. Prosze wybrac¢ interwat 5, i
szerokosc z lewej oraz prawej na 25. Aktywujmy opcje Unique points. Naciskamy OK.

Program umozliwia sprawdzenie przekrojéw na ekranie. Ta opcja jest dostepna po wejsciu
Cross Sections -> Edit Cross Sections (lub na wstgzce Cross Sections -> Edit -> Check). Wybieramy
Demo2.TRA, po czym program powinien wysrodkowac przekrdj na catym ekranie. Aby przesuwac sie
po kolejnych przekrojach nalezy nacisng¢ Next lub Previous (czarne strzatki na gérnym pasku).
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Uruchomimy teraz narzedzie Cross Sections -> Draw Cross Sections (lub na wstgice Cross
Sections -> Drawing -> Draw). Ustawmy rozmiar strony na DIN-AQ, pozioma oraz pionowg skale na 500
oraz Model Space.
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Projektowanie niwelety

Dotychczas, w celu zaprojektowania profilu podfuznego wskazywalismy wierzchotki osi drogi i
program automatycznie generowat profil w oparciu o DTM (NMT). Nie definiowalismy natomiast tukéw
pionowych rozpatrywanej niwelety. WejdZmy w Profiles -> Edit Profile (lub na wstgzce Profiles -> Edit
-> Check profile). Terazw oknie edycji profile, nacisnijmy Vertical alignment -> New. Zapiszmy plik pod
nazwa survey.ras.
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Po stworzeniu niwelety, zdefiniujemy jej wierzchotki wpisujgc je w miejscu, ktdre pojawito sie

W prawym gornym rogu.
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Teraz zdefiniujemy tuki pionowe wpisujgc ich parametry — dwie parabole z parametrem KV
rownym 845 dla drugiego wierzchotka oraz 260 dla trzeciego. Obserwujmy jak pozostate parametry sg
wyliczane automatycznie.
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Aby zakonczy¢ proces tworzenia niwelety, zapiszmy profil do pliku survey.ras.

DEFINICJA SZABLONU

Przed uzyskaniem kompletnego zestawu przekrojow poprzecznych, musimy zdecydowac jak
bedzie wygladat szablon dla naszej drogi. Program zawiera biblioteki m.in. jezdni, nawierzchni oraz
rowow, ktére mozna dodad oraz ustawi¢ wedtug potrzeb.

Jezdnie

Wejdzmy w Templates -> Define/Edit (lub na wstgzce Templates -> Creation -> Define/Edit).
Zapiszmy jako survey.scc. W oknie, ktore sie pojawito, mamy do wyboru kilka typéw jezdni, ktére moga
by¢ zmieniane w zaleznosci od potrzeb.
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Prosze wybrac szablon Sec-Urban2C i naciskamy OK. Wybieramy teraz graficznie naszg os drogi
lub naciskamy F i wybieramy plik z zapisang linig.

Pojawi sie teraz nowe okno do konfiguracji parametrow, ktére stanowi¢ beda nasz szablon.
Celem jest zdefiniowanie drogi, w ktérej po 200 metrach zacznie sie kraweznik i bedzie szedt az do
konca drogi.
‘ °~, po czym pojawi sie nowe okno z wypisanym
kilometrazem ostatniego punktu na osi drogi. Jesli sie zgadza, naciskamy OK.

Naciskamy przycisk wstawiania
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W podobny sposéb prosze wprowadzi¢ dane dla kilometrazu 200. Prosze jeszcze raz nacisngc
przycisk wstawiania, po czym wpisac¢ 200.

W momencie, gdy mamy juz dwa punkty w kilometrazu, o ktére nam chodzito, mozemy
zmodyfikowa¢é niektdre wartosci na kazdym stanowisku, co wida¢ na powyzszym rysunku.

Czasami trzeba zmieni¢ przechytke niektérych elementéw. Jesli przesuniemy kursor po
nagtdwkach kolumn i nacisniemy prawy klawisz myszy, znajdziemy tam opcje Activate/Deactivate
Superelevation.
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Po zdefiniowaniu jezdni, widzimy, ze potrzebujemy tylko jednej linii po kazdej stronie zamiast
dwdch, ktore sie teraz wyswietlajg. Aby usunac linie, najedZ myszka na kolumne Line2, kliknij prawym
klawiszem myszy i wybierz Delete. Wykonaj tak po dwdch stronach drogi.

Nawierzchnia drogi

Aby zdefiniowac nawierzchnie drogi, wybieramy zakfadke o tej nazwie i naciskamy przycisk w
stawiania jak przy jezdni. Zatwierdzamy OK. W wierszu zmieniona zostanie szerokos¢ (thickness) na 1
oraz Criteria zostanie zmienione na Slope, a Pend/Cond ustawimy -4. Wynik zostat zobrazowany na
ponizszym rysunku.
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Rowy

Aby zdefiniowac rowy, musimy przechodzimy do odpowiedniej zakfadki. Naciskamy przycisk
wstawienia jak poprzednio i pojawi sie okno z predefiniowanymi ustawieniami rowéw. Mozemy dodac
nowe lub edytowac istniejgce. W tym przypadku wykorzystamy réw nr 1, lecz z pewng modyfikacja.
Naciskamy Insert Nxt i wpisujemy nowe ramie rowu 0.5 po Xi0.25po Y.

0
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Po zatwierdzeniu okna, zostaniemy zapytani o to, od jakiego kilometrazu do jakiego bedzie
wystepowat projektowany réw. My zaznaczymy Assignment by Intervals i ustawimy Initial Station na
100 a Final Station na 200. Jesli przesuniemy sie do tego kilometrazu, zauwazymy pojawienie sie rowu

na ekranie.
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Pochylenia wykopu

Aby zdefiniowaé¢ wykop na przekroju poprzecznym, wchodzimy w zaktadke Cut i nacisngc
przycisk wstawiania. Pojawi sie ponizsze okno, gdzie zaznaczyé musimy odpowiednie nachylenie i
wpisaé wartosc tego nachylenia (co jest wynikiem podzielenia zredukowanej dtugosci przez wysokosc
nachylenia) 1.5 (dla rozpatrywanego wariantu nachylenie wynosi 60%). Po zatwierdzeniu musimy
wybraé, gdzie ma sie pojawi¢ nasz wykop. Zaznaczmy, ze bedzie ono do korca naszej osi (End Station).

-]

Koncowy efekt projektowania przekroju bedzie zblizony do ponizszego rysunku.
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Pochylenia nasypu

Procedura jest identyczna jak z wykopem. Wchodzimy do odpowiedniej zaktadki (Fill) i
wybieramy opcje wstawienia. W tym przypadku wybieramy wartos¢ nachylenia 0.667.
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Definicja poszerzen

Zostang teraz zdefiniowane pobocza drogi zwigzane z naszg osig. Aby tego dokona¢ wchodzimy
w Segments -> Widenings -> Generate widenings, program zapyta nas o nasza o$ drogi, po czym
automatycznie stworzy plik z poszerzeniem jezdni survey.sob.

Mozemy teraz wyswietli¢ informacje na temat naszych poszerzed wchodzac w Segments ->
Widenings -> List of widenings. Wybieramy plik utworzony wczesniej.
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Widenings Report o e
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W momencie, w ktorym ukonczyliSmy nasz standardowy przekréj oraz pozostate elementy
tworzgce droge (pozioma o$ drogi, niwelete, profile i przekroje), mozemy je zgrupowac w taki sposdb,
ze od tego momentu, bedziemy mogli pracowaé na jednym pliku, ktéry zawiera¢ w sobie bedzie
zgrupowane poszczegoélne elementy.

Wchodzimy w Segments -> Define -> Edit (lub na wstgzce Sections -> Creation -> Define/Edit)
| wybieramy nazwe dla nowego pliku survey.seg. Nastepnie importujemy pliku w nastepujacej
kolejnosci SURVEY.EJE, SURVEY.LON, SURVEY.TRA, SURVEY.RAS, SURVEY.SOB, SURVEY.SCC i
SURVEY.PER. Mozna réwniez nacisnac przycisk Automatic i zaimportowad automatycznie te pliki, ktére
majg takg samg nazwe jak rysunek.

Mozemy zaobserwowad, ze po imporcie pliku z poszerzeniami, pojawi sie okno, w ktérym
program zapyta nas o punkt zastosowania i w naszym przypadku wybierzmy Outer lane.

Widenings ﬁ-‘
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Element File Irikial Statian Final Station Date o
ALIGNMENT survey. EJE 0.000 507 067 23/04/11
PROFILE survey LON 0.000 507 067 03/09/14
CROSS-SECTIONS survey. TRA 0.000 507 067 03/09/14 E
GRADE LINE survey, RAS 0.000 507 067 09/09/14
WIDENINGS survey, SOB 0,000 507 067 03/09/14
TEMPLATES survey. SCC 100.000 507 067 09/09/14
SUPERELEVATIONS  survey.FER -4.000 507.067 03/09/14
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Rysowanie profilu podtuznego

Teraz mozemy w sposéb kompletny dokona¢ prezentacji naszego profilu podtuznego niwelety
oraz przekrojéw poprzecznych. PrzejdZmy do Segments -> Draw Longitudial Profile (lub na wstazce
Segments -> Drawing -> Draw Longitudal Profile). Wybieramy plik z catym naszym segmentem tj
survey.seg. Wprowadzamy skale pozioma 1000 i pionowa 200 oraz parametr Verticles to represent
ustawiamy na Constant i wprowadzamy wartos¢ 10. Naciskamy OK.
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Automatyczna aktualizacja profilu

Po wygenerowaniu profilu podtuznego, zauwazyliémy, ze wprowadzony zostat btedny
parametr KV dla jednego z fukéw pionowych. Wchodzimy w Grade Line -> Vertical Transition Curve i
wskazujemy naszg niwelete. Ustawiamy parametr KV na 890 w sekcji Current Vertex, po czym
zatwierdzamy enterem, aby pozostate parametry ulegty rekalkulacji. Naciskamy OK.

i Editing Grade Line Vertices @
Vertices
< < > » |
Previous vertex Cument vertex Next vertex
Station l— Station 7000000 | Station #‘
Height 365.800000 Height W Height |—|
kv kv oo | K o |
aow [0 ; ow B3 fow [
Tangent [7 Theta 0.145451 Tangent [23961—\
Ditonce  [1425%6 | Tangert  [64744 | Dstance  [2992% |
Sope  [184810 f Pov s [ Sope  [670103 |
[ Select < \ Crossing point <
| Calculate Volume
ok ] Apply Cancs! ([ Heo.. |
\.

Po zatwierdzeniu okno mozemy spostrzec jak program automatycznie aktualizuje profil
podtuzny, po czym pojawia sie wiadomosé, czy chcemy zaktualizowac pozostate segmenty. Naciskamy
OK. W tym momencie, po naszej zmianie, wszystkie dane bedg aktualne.

Rysowanie przekrojow poprzecznych

Aby wygenerowac nasze przekroje poprzeczne, wybierzmy Segments -> Draw Cross Sections
(lub na wstazce Segments -> Drawing -> Draw Cross Sections). Wybieramy plik survey.seg. Wybierzmy
rowniez format rysunku na DIN-AO, pozioma oraz pionowa skale na 500, wpisujemy tytut, wybieramy
Model Space. Naciskamy OK. Zostang wygenerowane przekroje poprzeczne na dwéch arkuszach
formatu AO.
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Zapiszmy rysunek jako survey.dwg.

Zestawienie plikow

Po skoriczonej pracy, w folderze z projektem powinnismy mieé¢ nastepujgce pliki:

Plik Opis
survey.DWG Oryginalny rysunek
survey.EJE Plik zawierajgcy o$ drogi
survey.SUP Plik zawierajgcy zmodyfikowang powierzchnie terenu
survey.LON Plik zawierajgcy oryginalny profil podtuzny
survey.TRA Plik zawierajgcy oryginalne przekroje poprzeczne
survey.RAS Plik zawierajgcy niwelete
survey.SCC Plik zawierajgcy szablon
survey.SEG Plik zawierajgcy segmenty
survey.PER Plik zawierajgcy przechytki
survey.SOB Plik zawierajgcy poszerzenia jezdni
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Cwiczenie 5 — Definicja wamocnien

W tym przykfadzie postuzymy sie projektem, w ktédrym droga juz istnieje. Celem tego éwiczenia
jest stworzenie nowej, bardziej jednolitej drogi z nowym ukfadem w taki sposéb, aby ponownie uzy¢
istniejgcej powierzchni drogi tam, gdzie obie drogi, w stosunku do swojego uktadu, zbiegajg sie i réznica
terenu na to pozwala.

Otworzmy rysunek REINFORCEMENTS.DWG, ktéry znajduje sie w katalogu C:\MDT7
Samples\Tutorial05.

Nastepnie importujemy o$ drogi poprzez Alignment -> Import Alignment o zaznaczamy
ALIGNMENT.EJE.
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W tym momencie wygenerujemy przekroje poprzeczne terenu. Prosze wejs¢ Cross Sections -
> Get Cross Sections i ustawi¢ parametry dla przekrojéw co 5 metréw oraz dtugosci przekrojow dla
strony prawej | lewej na 15 metréw. Nazwijmy powstaty plik REINFORCEMENTS.TRA.

= -
Cross-section E
' Suface DA\ \einforcements SUP
File ‘ D \veirforcements. TRA
| Source... Configuration
— Sampiing
Inttial Station 0.000
| Unique Points
Final Station 870.839 i -
ances;
v Draw Cross Sections T
Profile Length i) oraection with /sgnment
Left 15 | /| Interva 5,000
Right 15 | Curve Distances 5.000
Cut ines...
Ends Advanced ...
o Cut Direction
Repeat @ Direct
Intepolate
Options . Inverse
| ok | Cancel | Help ...

Definicja segmentu

Po wygenerowaniu przekrojow poprzecznych, skupimy sie teraz na stworzeniu segmentu. Dla
potrzeb tego éwiczenia, pozostate elementy drogi zostaty juz utworzone wczesniej tj. profil podtuzny,
niweleta oraz szablon. Prosze wejs¢ w Segments -> Define/Edit. Nowy plik nazwijmy
reinforcements.segq. i sukcesywnie importujmy z gtéwnego folderu z projektem poszczegdlne elementy

ALIGNMENT.EJE, REINFORCEMENTS.LON, REINFORCEMENTS.TRA, REINFORCEMENTS.RAS,
REINFORCEMENTS.SCC.
r ~
Segment definition - [CAMDT7 Projects\Tutorial05\reinforcements,SEG]

Components
Element File Initial Station Final Station Date
ALIGNMENT Alignment. EJE 0.000 870.839 21012
PROFILE reinforcements. LON 0.000 870.833 21012
CROSS-SECTIONS reinforcements. TRA 0.000 870,839 03/09/14
GRADE LINE reinforcements. RAS 0.000 870.839 2210n2
WIDENINGS
TEMPLATES reinforcements. SCC 870.839 870.839 03/09/14
SUPERELEVATIONS
BLOCKS

Automatic Ex [
Ed aleul

Ep!icuns Preview

‘ Venly... l Generated without erors

[ Check. | [Vokumes Report

‘ Draw... ( | Modiied...

‘ Top view I Expor

‘ Feport E Z
[ ok | Cancel [ Heb |
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Podglad segmentu ukazuje ograniczenia drogi,

wykorzystania powierzchni drogi.

Definicja wzmocnien

dla ktérych dokonamy ponownego

Po stworzeniu segmentu, dokonamy modyfikacji standardowego przekroju biorgc pod uwage
powierzchnie juz istniejgcej drogi z perspektywg wykorzystania jej powierzchni.

Wejdimy w Templates -> Define/Edit wybierajagc nasz segment reinforcements.seg.
Wchodzimy w zakfadke Reinforcements — Others.

Flatioms | Roadbeds | Diches | Ct | Fit

Cleaing Bemms defirstion

Stalion DX oY Sel Up Side

Insest. Delete

OF

€ Stabion

[ Saving | Wals

0000 Zr=540.705

Stachuie | Geokogy| Feiéorcement - Dthers

Aeinforcement defniton
o Apply i

Tokesance
Wi D 0 500

Mo DF 0500

Appication methads

Diesignate pakines

Top view

Delirution of routings

Lavers

S .

Dfindion

Cancel

Ustawiamy minimalng tolerancje na -0.5 oraz maksymalng na 0.5 w miejscu Minimum Dif. i
Maximum Dif. Dla potrzeb obecnego ¢wiczenia zaznaczamy Adjust to terrain.

Nowa droga musi by¢ réwniez wskazana w miejscu wystepowania drogi istniejgcej. Aby to
zrobi¢ nacisnijmy Design Polylines i w naszym przypadku wskazmy dwie polilinie, ktére wskazuja

granice naszej drogi.
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Dodatkowo, jesli przejrzymy poszczegdlne przekroje, mozemy zaobserwowaé na niektoérych
przekrojach dwa czerwone symbole, ktére wyznaczajg punkty, przez ktére przechodzi droga do
ponownego wykorzystania i jak standardowe przekroje adaptujg sie do istniejgcej powierzchni drogi.

Reference Road

“ P Staion 25000 Zi= 563427

Platioims | Roscbeds | Ditches | Ct [ Fd | Saving | Wasks - Shuchue | Geooge| Rerdorcenant - Other

Clasing Beime: defirson Resnborcamernt defira Drahrdion of outings
7\ Apply Lawess

Station DX DY Setlp Side Toletance
Minimum D 05008
Masimum D 050
Agphcation methods f -
| At bo tenan 1
Rerforcament e TR )

L o Dabis e Deetion
ok, Top view Cancel

Nastepnie narysujemy segment poprzez Cross Sections -> Draw Cross Sections wybierajgc plik
reinforcements.seq. W naszym rysunku bedziemy obejrze¢ jak przechodzi droga, ktérg ponownie
chcielibysmy wykorzystaé na niektérych przekrojach.

Profile N. 8 o 000 - Prof

Aby dokonczy¢ projekt, mozemy wykonac obliczenia mas ziemnych, w ktérych ukazane bedg
wyniki dla naszej powierzchni oraz projektu drogi. WejdZmy do Volumes -> Roadbed Measurements
Report i zaznaczmy nasz segment reinforcement.seg i zatwierdzamy okno, w ktérym zaznaczamy na
jakim fragmencie dokona¢ obliczen (u nas na catym odcinku od stanowiska poczatkowego do
koncowego).
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Po dokonaniu obliczen, ukaze nam sie okno z wynikami obliczenia mas ziemnych.

ILB. |LIRE|LOLE |LDRB ROAD SURFACES L -HAND SHOULDEFS R.-HAND SHOULDEFROADBED VOL.3 REINFORCEMENTSEINFORCEMEMNT VOL Sup RefRod
000 0000 5000 5000 70.000 12500 12500 80.800 0.000 0.000 0,000 |1
0000 0000 5000 S000 70.000 12.500 12500 80.800 0.000 0.000 0.000
5000 0000 O0DOD 5000 5000 70.000 12500 12500 80.800 0.000 4021 0,000
0,000 0000 10000 10.000 140,000 26,000 25000 161.600 0.000 4021 0.000
10000 0000 0000 S000 S000 70,000 12500 12500 E0E18 1.608 8010 35050
0000 0000 15000 15000 210,000 37.500 37,500 22208 8.042 12031 35030
15000 0000 0000 5000 5000 70,000 12.500 12500 60.754 15% 7.982 35030
0000 000D 20000 20000 220,000 50.000 50.000 283172 16.020 13983 70.060
20000 0000 0000 5000 5000 70,000 12.500 12500 60.703 1585 78% 35.030
0000 0000 25000 25000 350,000 62,500 62500 343875 231347 27873 105,050
25000 0000 0000 6000 5000 70.000 12,500 12500 60635 1572 7838 35,035
0000 0000 30000 30000 420,000 75.000 75.000 404511 e /77 140125
30000 0000 0000 5000 5000 70.000 12,500 12500 60582 1.562 7.784 35030 -
« il b
TOTAL
Left interice white ine lenght 0.000
Right irteror white line lenght 0,000
Left exterior white line lenght 875.434
Rlight extesior white line lenght 680,455
Fioad suface 12131746
Left Hard shoulder suface 2188.734
Right hard shoulder suface 20213
Foadbed volume 13274543
Reinforcement Surface 5601.750
Renforcement Volume 5606. 752
Explanade reinforcement suface 8189.803
oK ] Print... Help |
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CWiczen ie 6 —Szablony z rysunku

W tym c¢wiczeniu rozpoczniemy od danych pomiarowych, w ktérych mamy okreslony teren
oraz zdefiniowane linie nieciggtosci, ktére wyznaczajg droge. Celem tego przyktadu jest przypisanie
parametréw do tych polilinii i odczytanie rysunku przekroju oraz automatyczne jego zbudowanie.

Po wygenerowaniu szablondow, stworzymy segment drogi i inne pliki w tym projekcie oraz
podejrzymy ostateczny status szablonu.

Dla wtasciwego zrozumienia kolejnych krokéw, zalecamy zapoznanie sie z poprzednimi
¢wiczeniami zawartymi w tym podreczniku.

Otworzmy rysunek survey.dwg z folderu C:\MDT7 Samples\Tutorial06.

Na poczatku nadamy poliliniom okreslone parametry. My posiadamy dwie polilinie znajdujgce
sie na warstwie CURB (kraweznik), ktédre musza pasowaé¢ do dwdch wektoréw z naszego szablonu
wyznaczajacych niski i wysoki kraweznik.

Przyporzadkujemy tym poliliniom dwa rézne zachowania. Linia przy podstawie kraweznika.

PrzejdZzmy do Templates -> Assign Properties to Vector Platform (lub na wstgzce Templates -
> Creation -> Prop. Vectors) | wybierzmy dwie polilinie z warstwy CURB zaznaczone na czerwono.
Pojawi sie wtedy nowe okno z funkcjg przypisania atrybutéw.
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Assignmentof layer name [=s]
Layer name
Vectors
DX DY P Insett...
Change .
[ ][ ]8 [ Deete |
[] Change polylines color l Color
[ oK [ Cancel [ Help..

Teraz przypiszemy parametry, o ktérych wspominaliSmy wyzej. Dla niskiego kraweznika
wpisujemy 0 w DX oraz DY i naciskamy Insert. Dla wysokiego wartosci te bedg odpowiednio 0.01i 0.20.
Ponownie naciskamy Insert.

Layer name
MDT_xOyON_x0.01y0.2N

Vectors

DX oY P

0.000 0000 NO
0.010 0200 NO

(L J [ _18

"] Change polylines color

Change ... |
|

l | [ Concel |

Mozemy zauwazy¢, ze utworzona zostanie nowa warstwa, ktdra stanie sie warstwa
referencyjng dla utworzenia nowego kraweznika.

{%i\lpolyline v
Color ' Red
Layer |MDT_x0yON_x0.01y0.2N
‘ Linetype \— Bylayer
| Global width 0.000
Closed [No

Po przyporzadkowaniu parametréw do poszczegdlnych polilinii, stworzymy teraz szablon w
oparciu o dane z rysunku.

Aby tego dokona¢, wejdzmy w Templates -> Convert Platforms from Drawing (lub na wstgzce
Creation -> Convert Drawing). Wpisujemy nazwe dla nowego pliku road.scc. Wybieramy naszg o$
drogi, co mozna zrobic na rysunku lub wybierajac plik road.eje. Pojawi sie teraz ponizsze okno.
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[ Poyines of piatiomn

| Ly | Opiong
Parametars Vertices o arakae
— m ¥ NI Cute
i Stalion P[}Dﬂ— | —
- | Dracretization ntanval 2o |
i 507.067 » o
e : Mnmum dsiance betwesn assionments 0500
Mex. distance o Algrmerl 20 2 Additioral Stetors...
Cut poiybnes | | Vachors assgred
Ok | Caced | Help ...

Zmodyfikujmy parametry wyswietlone w oknie. Nacisnijmy przycisk Layer, aby wybraé

warstwy, na ktérych sg polilinie, ktérych potrzebujemy do wygenerowania szablonu, podobnie jak na
rysunku ponizej.

Layer Selection -I'T
Layere Avainhie Lawere: Cadeoted
0 CURE
- LAKET
ALIGNMENT r DT oy DN _s) Dpid 2t
GLEADRAIL 3 | PeARING
- SIDEWALK
5
Seioct <
e ] [ Load
o Cancel | Help

Prosze nacisngé OK, a nastepnie Options. Wpiszmy tolerancje pozioma oraz pionowa 0.001.

Platform Cptions
Talkmnces
Honzortal 10.001
Verica 0.001
COptiora

| Consider Supssl=yvations
] Interalate Patforme

[ ok | | Coneed | Help ...

Naciskamy dwa razy OK. Nastgpi automatyczne utworzenie pliku szablonu z informacjg o
wszystkich jezdniach. Uruchomimy Templates -> Define/Edit (lub na wstazce Templates -> Creation -
> Define/Edit) | wyswietlimy plik szablonu, ktéry utworzyliSmy. Prosze zauwazy¢, ze na rysunku
znajduje sie juz zdefiniowany kraweznik.
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W tym oknie, podobnie jak w Cwiczeniu nr 4, ustawiamy pochylenie na 1 dla wykopu oraz
nasypu, aby dokonczy definicje szablonu. Ustawmy opcje jak na rysunku ponize;j.

Type Section defewt on - |0/ MOTE Progsct Turoral ¥ imsd 5001

c o ” F PrE i < a 7 v

Flathomrs | Asarbsont | Dikshos | Cutreg | F9 fiovg | ‘i - Sk | Grskeye | Aok - Chen
Fil Kl
Siatian Hape =] Intsmaliie
900 1=l gt | ; o
2]

[T’ T s Lancs:

Kolejnym krokiem jest utworzenie segmentu drogi, uruchamiajac polecenie Segments ->
Define/Edit (lub na wstgzce Segments -> Creation -> Define/Edit) i importujemy poszczegdlne pliki z
folderu gtéwnego jak juz robiliSmy to wczes$niej. Powinno to wygladad tak jak na rysunku ponizej.
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Comporents
Elesver: Fie bzl Station Final Sxalion Date =
ALIGHHENT wad EE nom 507067 23'M
PAOFILE cad LOM o BOT.0E? 2/M411
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[ e Moo

| Tapvem Expatt ot
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Po stworzeniu segmentu, mozemy teraz zobaczy¢ jak wyglada nasza droga. Prosze uruchomi
Maps -> Render -> Route by Road (lub na wstgzce Maps -> Render -> Viewer -> Route by Highway).

WiarD
T T R i [T —

OO B B ST MR W JEEM e She
(L= Lol e | Tepgh e L1 L) XA Y Ralates

BTGB VA0S 1 Cptac ST & Burc 1000 P wcorssnda Tawwn T FTIST A0 Vo A0S AB Cotw del iwenoc WTAT
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CW'Cze nie 7 — Definiowanie i obliczanie warstw drogowych

Celem tego ¢wiczenia jest zdefiniowanie powierzchni i warstw drogi oraz obliczenie objetosci
mas ziemnych dla kazdej z warstw drogi.

Na poczatku zdefiniujemy przekrdj z polilinii, ktéry reprezentowat bedzie koncowy stan
naszego przekroju. Otwdrzmy rysunek layers.dwg znajdujagcy sie w folderze C:\MDT7
Samples\Tutorial07.

Definicja przekroju

Wejdimy w Templates -> Define from Polyline in Eleation View | nazwijmy nowy plik
layers.scc. Nastepnie wybierzmy plik z osig drogi layers.eje i ostatecznie polilinie, ktéra bedzie
stanowita nasz szablon.

Pojawi sie ponizsze okno, w ktdrym zdefiniujemy punkty startowe w kazdym z elementéw
przekroju.

l Define from polyline in

Azaignmant Station
Type section

Platiom Aigrment Postion <
| Left Dech = Start Point <
Faght Cech - Stat Point =
Left shape Start Poit <

Fight slape: Stat Poit <

Nawierzchnia drogi — zdefiniujemy srodek nawierzchni, ktéry stanowi bedzie srodek naszej osi
drogi.

Lewy row — ustawimy koniec nawierzchni drogi jako punkt potaczenia miedzy nawierzchnig a
rowem. Zdefiniujemy to tylko dla wykopu.
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Prawy row — Wytgczymy prawy réw z uwagi na to, iz nie bedzie go po prawej stronie drogi na
catej dtugosci

Lewe nachylenie — Podobnie jak z lewym rowem, wskazujemy potgczenie na korncu brzegu
drogi. To nachylenie bedzie tgczyto sie z wykopem.

,—

Irtarpcton

Prawe nachylenie — Wskazujemy punkt potgczenia znajdujay sie na koricu nawierzchni drogi
po prawej stronie. Bedzie to dotyczyto nasypu.

Ostateczny wyglad naszego przekroju bedzie wygladat jak ponizej.

ne from polyline

Essigriment Stetior [507.670
Type section
Flatfam Alignment Position ©
LDk 7] [ Sapoe ]
7] Leftalogs ‘:'J"—'I | Siad Point< oK
7 Rant sope Gl | [ St Pairt < oK
[ ok | | Conesl | Hep .|
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Zatwierdzamy okno i standardowe przekroje automatycznie pojawig sie w linii z parametrami,
ktére wiasnie zdefiniowalismy.

Program automatycznie nadat nazwe L1 oraz R1 do linii nawierzchni. Dlatego wiasnie, przed
zdefiniowaniem powierzchni, zmienimy jej nazwe na Lanel. Mozemy to zrobi¢ zaznaczajgc nazwe linii

uzywajac prawego klawisza myszy i wybierajgc opcje Change Vetor Type. Ostateczny wynik powinien
by podobny do ponizszego.

you Tection deinition - [CIMDTT Semper fsrplol fime 500

Pl |Foeded Dusbes | O | Fl G | Wil -Ganote | Fsolege | Festomnest - o

Slsioa n Aigrwerd m |
| 0w per i B @

Definicja nawierzchni drogi

Zdefiniujemy teraz powierzchnie oraz warstwy powierzchniowe z nig zwigzane. Wejdzmy w
zaktadke Roadbed i zdefiniujmy grubosé¢ na 1 (thikness) z kryterium Parallel.

Nastepnie naciskamy przycisk Roadbed Layers = i definiujemy 3 warstwy jak na ponizszym
rysunku.
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Total Thickness: 1.00m

Calzada

Layer

Roadbed Slope: 1.500

Arcén

B.Mix

Art.Ballast

Natural Ballast

Thickness  |Shoulder Dist

Berma

Slope Overlap Mat.

Roadbed Layers Li:

u
1 0.200 0.000 1.000 B.Mix
2| At Ballast 0.400 0.000 1.000 B.Mix
3| Natural Ballast 0.400 0.000 1.000 B.Mix
[ 0K ] [ Import.... ] [ Export... ] [Matetials...] [ Print ] [ Cancel j
Road Mat. Thickness
B Mix 0.2
Art Ballast 0.4
Natural 0.4
Ballast

Road Mat. okresla rodzaj materiaty, z ktérego zbudowane beda warstwy drogi.

Definicja segmentu oraz pomiar warstw

Po utworzeniu standardowego przekroju, zajmiemy sie zbudowaniem segmentu. Wejdzmy w
Segments -> Define/Edit i nowy plik nazwiemy layers.seg. Importujemy poszczegdlne elementy drogi
jak poprzednio. Mozemy znalez¢ odpowiednie pliki w folderze z projektem obok pliku z przekrojem,
ktory wiasnie utworzylismy.

Segment definition - [CAMDT7 Projects\Tutorial07\layers.SEG]
Components
Element File: Initial Station Final Station Date it
ALIGNMENT layers.EJE 0.000 507.067 29/04/11
PROFILE layers.LON 0.000 507.067 21/08/14 |
CROSS-SECTIONS  lavers.TRA 0.000 507.067 21/08/14 £
GRADE LINE layers. RAS 0.000 507.067 21/05/14
WIDENINGS
TEMPLATES layers. SCC 507.067 507.067 03/09/14 M
SUPERELEWATIONS
BLOCKS 52
[ Impaort... ] [ Automatic ] Select [ Expart... ] [ Delete... ]
Wiew / Edit... List. Frint. Recalculate. Avanzadas
Options Preview
Generated without errors
[ Check... ] [Volumes Heport...l
[ Daw. | [ Modied. |
Export routing
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Po zbudowaniu naszego segmentu drogi, mozemy go teraz narysowac. Aby tego dokona nalezy
wejs¢ w Cross sections -> Draw Cross Sections i zaznaczamy segment, ktdry stworzyliSmy niedawno.
W oknie, ktore sie pojawi naciskamy Advanced i aktywujemy opje Draw Roadbed Layers.

St - —— Se=mmm
[ET—— ] |
|| Represent structures Block...

Draw Roadbed layers
[”] Draw geologic layers

Direction of drawing Grid i— - -
@ Normal Draw | ] | l |
& R Divisions | - 1 e 1 1 . |
Tt Horizontal ¢ J I I » I J

Vettical b ]

STANDARD B Line widht 0.000
Position of Texts
(@ Alignment to center () Alignmert to left —— —_— ——— -

(k] [(Gos] (oo H—+—1111 =

Nastepnie obliczymy ilos¢ materiatu potrzebnego do zbudowania konkretnych warstw drogi.
PrzejdZimy do Volume -> Roadbed Layers Measurement Report, zatwierdzamy z domyslnymi
parametrami.

Station | Material | Surface Yolume -
(i, B Mix 0.000 0000 |=|

0,000 At Ballast 0.000 0.000

0.000 Natural Ballast 0.000 0.000

5.000 B.Mix 0.000 0.000

5.000 ArtBallast 0.000 0.000

5.000 Natural Ballast 0.000 0.000

10,000 B.Mix 0.000 0.000

10,000 ArtBallast 0.000 0.000

10,000 Natural Ballast 0.000 0.000

15,000 B.Mix 0.000 0.000

15,000 At Ballast 0.000 0.000

15.000 Natural Ballast 0.000 0.000

20,000 B.Mix 0.000 0.000

20,000 ArtBallast 0.000 0.000

20,000 Natural Ballast 0.000 0.000

25000 B.Mix 0.000 0.000

25,000 At Ballast 0.000 0.000

25,000 Natural Ballast 0.000 0.000

30,000 B.Mix 0.000 0.000

30,000 ArtBallast 0.000 0.000

30,000 Natural Ballast 0.000 0.000
W/WNNN R Miv nnnn nnnn T

TOTAL Volumes
B.Mix 0.000
At Ballast 0.000
Natural Balast 0.000
TOTAL 0.000
( oK ] | Print... ] Help
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CW'Cze nie 8 = Uzyskiwanie zmodyfikowanego terenu

Otwoérzmy plik z rysunkiem survey.dwg zlokalizowany w folderze C:\MDT7 Sample\Tutorial08.

Teraz wybierzmy Surfaes ->Get Modified Terrain (lub na wstazce Surfaces ->Earthworks -> Modified
Terrain), nacisnijmy F | wybierzmy plik survey.seg. Aktywujmy opcje Surface, aby nowa powierzchnia zostata
stworzona i zapisana jako survey2.sup, pozostawiajgc oryginat nienaruszony. Pozostawmy reszte parametrow tak
jak jest na ponizszym rysunku.

Get Modified Terrain
Limits Height

Initial Station ) Sail
,
Final Station 460.998 @ Roadbed

Drawing

Paints

Cross-Section Lines [ Elements...
[7] Blocks Blocks
Cross-Sections

[7] Slope Drawings
[¥] Cut Break Lines
Result

[V] Surface survey2.SUP | File...

Options
[ Interpolate

[T Recalculate Matural Temain

Wiz

[ ok ] [ cancel | [ Hep.. |

Naciskamy OK. Po przeprowadzeniu obliczen, rezultat zostanie wyswietlony na ekranie.

Oryginalny teren jest automatycznie modyfikowany, aby pokazaé¢ nowag droge i nowg
powierzchnie pod nim. Jesli uzyjemy opcji Quick Profile, mozemy przejrzeé jak zmienit sie teren.
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Quick Profile

Separators i v
Horzontsl (5 | Vettical |1 -] Station: 34,141 Height: 373.342
: Sl Height Prafil
‘ertical Factor l‘l v‘ A::[de e g rofile
. itial Hei ini Save...
Length 48,206 Mirimum 0,240 Initial Height ~ 364.000 Minimurn 358.000
[k ) Masimum 150,464 Final Height ~ 358.000 Masimum  364.000 Draw Alln.

Lista pomiarow objetosci

Nastepnie, utworzymy liste objetosci dla drogi. PrzejdZzmy do Volumes -> Cubic Measurement
List (lub na wstazce Volumes -> Sections -> Cubic Measurement List). Wybieramy survey.seg |
naciskamy OK.

Cubic Measurement List ==
Interval Methods of Calculation
Initial Station 0.000 @ Average Areas

Final Station 460,998 Prismatoids
Curvature Comection

Parameters
Minimum Surface 0.001
Muttipliers of volume

Decimal Numbers Cutting 1.000
Accumulated Volume Fil 1.000
Cutting List Type
Fill Normal
Org.Soil 0.000 @ Accumulated

| oK | ‘ Cancel | ‘ Help ... |

Zobaczymy raport z obliczeniami objetosci warstw dla kazdego przekroju poprzecznego.
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Cubic Measurement List =

Station Cutting Surf. Fill Surf. OrgSoil Surf. Cutting Yol Fill al. OrgSail Yol -
0.000 3772 0.000 0.000 0.000 0.000 0.000 |
) 1 162.042 2514 0000 |

5.000 33.045 1.005 0.000 162.042 2514 0.000

154.836 9.282 0.000

10.000 28913 2708 0.000 316.938 11.796 0.000

139.008 20533 0.000

15.000 26.630 5.508 0.000 455,946 32329 0.000

102,192 25.783 0.000

18.994 24.483 7.408 0.000 558,137 58118 0.000

24.371 7.576 0.000

20.000 23968 7.654 0.000 582.508 £5.694 0.000

117.162 38.924 0.000

25.000 22857 7.916 0.000 B39.671 104617 0.000

114773 36.143 0.000

30.000 23012 6541 0.000 814.444 140.760 0.000

119.853 26.560 0.000

35.000 24931 4.083 0.000 934.303 167.321 0.000

132673 15.276 0.000

40.000 28140 2027 0.000 1066.982 182597 0.000

151.623 7.146 0.000

45 nnn 27 Fna now nann 1910 enR 100749 nann

TOTAL
Cutt volume 12543839
Fill volume 2134.408
Organic volume 0.000
Difference [Cutt - Fill) 10409.431
Cleared vegetation surface 0.000
( oK ] Print... ] Draw | | Excel.. ] | Help

Lista objetosci

Nastepnie utworzymy powierzchnie i zrobimy liste objetosci, ktéra pozwoli nam przeprowadzié
obliczenia robét ziemnych.

PrzejdZmy do Volumes -> orss Sections Measurements Report (lub na wstazce Volumes ->
Templates -> Surfaces -> List of Cross Sections Measurements), wybierzmy plik survey.seg.

Wybierzmy opcje On ground plan.

Measurements List (=3

Initial Station 0.000
Final Station 460.998

Calculation type Surfaces

@ Surfaces 0

) Lenghts ") Developed

[ oK | [ Cancel | [ Hep.. |

Nastepnie, jesli nawierzchnia drogi zostata zdefiniowana w naszej drodze, zobaczymy okno, w
ktorym zaznaczamy warstwe na ktdrej chcemy dokonaé pomiaréw. W tej sytuacji pojawia sie tylko
warstwa niwelety poniewaz nie ustalilismy zadnej warstwy srodkowej dla nawierzchni drogi.
Zaznaczmy Grade Line i naci$nijmy OK.
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Select roadbed layer @
Type

Roadbed Layers

Subgrade

[ ok | [ cancel | | Hep.. |

Pojawi sie teraz lista powierzchni nawierzchni drogi wraz z pochyleniami dla kazdego pikietazu.

Cross-sections measurements on ground plan list =
Fill Crown Cutting Crown Fill Cutting Left wall FRiight 'wall Left wayside Right wayside -
E5.127 82336 0.000 23470 0.000 0.000 5.000 5.000 iE‘
65127 82336 0.000 23470 0.000 0.000 5.000 5.000
5.000 58.246 85.023 2180 24.830 0.000 0.000 5.000 0.000
123373 167.359 2150 48.300 0.000 0.000 10.000 5.000
10.000 71126 75.344 3.370 23510 0.000 0.000 5.000 0.000
194.433 242703 5.520 71.810 0.000 0.000 15.000 5.000
15.000 64.807 55.560 3774 18.740 0.000 0.000 3.994 0.000
259.306 298.263 9.294 90.550 0.000 0.000 18.994 5.000
18.934 17.071 13586 1.020 4617 0.000 0.000 1.006 0.000
276.377 311.850 10.314 95.166 0.000 0.000 20,000 5.000
20.000 85615 67.055 5.095 22.750 0.000 0.000 5.000 0.000
361.932 378.904 15.409 117.916 0.000 0.000 25.000 5.000
25.000 87.735 66.472 4.950 22125 0.000 0.000 5.000 0.000
449.727 445376 20.353 140.041 0.000 0.000 30.000 5.000
30.000 85.850 67.933 4235 21.875 0.000 0.000 5.000 0.000
635,577 513.369 24534 161.916 0.000 0.000 35.000 5.000
35.000 80.600 72360 3.075 22215 0.000 0.000 5.000 0000 -
TOTAL
Fill crown 7842.441
Cut crown 6357.477
Fill slopes 245536
Cutting Slopes 1947.393
wall Lit. 0.000
‘wall Rght. 0.000
Lit. Ditch 410,938
Rght. Ditch 117.190
( oK ] | Print... ] [ Help J

Lista pomiaréw nawierzchni drogi zostanie teraz pozyskana tj. powierzchnie drogi, dtugosci etc.
PrzejdZmy do Volumes -> Roadbend Measurements Report (lub na wstgzce Volumes -> Setions ->
Roadbends -> Measurements Report). Wybierzmy plik survey.seg | potwierdZzmy w kolejnym oknie.
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0

5.000 0.000

10,000 0.000

15.000 0.000
0.000
18.934 0.000
0.000
20,000 0.000
0.000
25000 0.000
0.000

Road surface

0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000

Leftinterior white fine lenght

Left Hard shoulder surface
Right hard shoulder surface
Roadbed volume
Reinforcement Surface

Reinforcement Yolume

Roadbed Measurements List

5,000
5000
5000
10,000
5000
15,000
3999
18,993
1.434
20433
3729
24222
3690
27913

Riight interior white line lenght
Left exterior white line lenght

Right exterior white line lenght

5.000
5.000
5.000
10.000
5.000
15.000
40M
13.001
2505
21.506
6271
27777
B.310
34.086

105.000 12500 12500 115.324
105,000 12500 12500 115324
107.436 12500 12500 93707
21243 25000 25000 215031
109673 12500 12500 105611
322303 37500 37.500 320641

83713 3997 10003 87984
412022 47.497 47503 1408625

22988 3736 6261 22502
435010 51233 53765 FEIREY
114746 9323 15677 112292
543756 50556 63442 543413
117.182 326 15774 114,703
566,938 69781 85216 658123

il
TOTAL
oK Print... ] | Help

0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000

=

Station |LILB. LIRE.|LOLB. LORB. ROAD SURFACE S.L-HAND SHOULDER S.R.-HAND SHOULDER|ROADBED YOL. | S.REINFORCEMENT | REINFORCEMENT VOL. | ~

0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0000 -
»

0.000
0.000
B16.725
722834
10210.103
1541.814
1807.234
11127.315
0.000
0.000

W tym przykfadzie objetos¢ podbudowy i wzmocnien jest rowna 0, gdyz nie zdefiniowaliSmy

ich jeszcze w szablonie.

Tyczenie

W tej czesci zajmiemy sie tyczeniem punktédw charakterystycznych drogi. Przejdzmy do Setting
out -> Setting out lines (lub na wstazce Setting out -> Segment -> Setting out lines). Wybieramy plik
survey.seg a nastepnie warstwe Gradient, ktéra bedzie analizowana | wybierzmy opcje Slope Top and

Bottom. Naciskamy OK.

Zdefiniujmy teraz gtéwne punkty, ktore okreslajg naszg droge. Aby tego dokonac przejdzmy do
Setting out -> Setting out lines, wybieramy plik survey.seg, po czym w nowym oknie zaznaczamy Grade
Line jako warstwe i naciskamy OK. Teraz wybierzmy Crown and Foot of Slope w sekcji Elements to set

out. Klikamy OK.
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Pojawi sie raport z listg wspotrzednych i innymi parametrami kazdego z punktéw do

wytyczenia.

Setting out Lines ==l
Stations Station Side
[7] Set out with Stations Initial Station O Left
] Final Station O Right
[ Unique Points @ Both
VG (e
[V] Cross-Section Changes [] Height Difference
i Additional Stations Code :]
N
—ee——t
e B
Interval Elements to Set Out
10.000 Cih e
Straight line Foukpils
Foot of Roadbed
Ditch P
Curve Crown and Foot of Slop 4
Wall o
Layer Thickness 2=
Special Codes ...
Value 0.000 ’ r ‘
[ Alingment distances... ]
OK | [ Cancel | [ Hep..

SETTING OUT LIST =
RET  Coord, ¥ Coord. 2 Coord. Code -
-16.860 335086.604 4084610.980 367.567 CFS
0.000 12632 335085.473 4084581.503 364.748 CFS
10.000 -17.604 335096.626 4084611.340 367.927 CFS ||
10.000 11.688 335095.502 4084582063 364699 oFs |7
20.000 -17.650 335106.055 4084611.01 36B.037 CFS ‘
20.000 12882 335105.862 4084580.433 364,435 CFS
30.000 17.345 335110.454 4084611.405 368146 CFS
30.000 13423 335119.911 4084582126 364.942 CFS
40.000 -17.355 335114.414 4084613436 368443 CFS
40.000 13.088 335132376 4084588.860 365.802 CFS
50.000 -17.647 335117.307 4084616.769 360742 CFS
50.000 12662 335141.958 4084539.135 366.435 CFS
51.065 -17.803 335117.437 4084617.242 368.791 CFS
51.065 12583 335142747 4084600.406 366.465 CFS
60.000 -19.423 335117.652 4084621198 369141 CFS
60.000 12395 335147.928 4084611.728 366.303 CFS
£9.203 -17.530 335125.096 4084633.680 368,390 CFS
69.203 14.304 335151.533 4084615833 366031 CFS
70.000 17718 3351265739 4084634.908 360426 CFS
70.000 14.234 335151.643 4084616.127 366.025 CFS
80.000 -16.683 335139.445 4084645.657 368347 CFS
80.000 13993 335154.362 4084618846 365.849 CFS
87.341 -14.876 335151.642 4084648180 367.023 CFS
87.341 14.413 335157.132 4084619.410 365627 CFS
90.000 -14.485 335156.010 4084648.360 366.702 CFS
90.000 14579 335158.128 4084619.374 365538 CFS
100.000 -16.558 335172745 4084647.971 367.937 CFS
100.000 15.080 335161.545 4084618.382 385.217 CFS ~
[ OK ] [ Print... ‘ [ Export... ] l Draw... } l Help ]

Teraz dokonamy analizy szablonowych wysokosci uruchamiajac polecenie Setting out -> List
of Heights (lub na wstazce Setting out -> Segment -> List of Heights). Wybieramy plik surey.seg i
zaznaczamy, ze bedziemy pracowaé na warstwie Grade Line jak poprzednio. Pojawi sie okno jak
ponizej, gdzie mozemy okresli¢ wektor, w ktérym chcemy przeanalizowac¢ wymiary i skonfigurowad
dane do analizy. Klikajgc > wybieramy, ktére wektory bedg braty w tym udziat.
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List of heights =)
Stations Side
Initial Station © Left
() Right
Final Station (@ Both
Vertices to list
Focoa e
gg Outer Hard Shoulc
n =
(oK ] [cawel ] [ Heb. ]

Po wybraniu linii do wytyczenia i zatwierdzeniu okna, pojawi sie raport.

[ SETTING OUT LIST

_Staton_| Outer Hard Shoulder Lane2 Lane 1 Algnment Lane1 Lane 2 Outer Hard Shoulder -
600 365,859 365,909 #5979 366049 385979 365,909 365,859
5000 385964 86014 366,089 386159 366,159 366,159 366,159
10,000 366,069 #6113 #6199 6269 386312 36,362 366,334

15,000 %6120 366,184 36230 #6378 366,467 #6573 38663 =
18.994 366095 366,184 386342 366,466 366591 3%6.748 36837
20000 366,088 366,183 366,355 366,488 366,622 36793 366,689
2500 366049 %6177 36419 36653 %6777 %7019 7147
3000 #6015 #6175 386423 366,708 36933 %7240 37401
3000 366,062 366,237 386573 36818 367,083 3%7.3% %2573
40000 #6172 38647 36,68 %6928 ®7173 3%7.508 %7683
45000 6282 386,457 %6722 %707 w7282 #7618 %779
50000 366494 36645 %6935 w7147 3%7.359 387,649 367,601
55000 86871 366,957 %7123 7243 367,362 %7528 B7.614
60000 w7207 %7226 3%7.266 w7292 %7319 37359 %7378
61.443 7.2 3%7.2% 7.2 37298 7.2 7.2 7.2
65,000 367.4% 367.451 37,350 3%7.2% ®7.28 367,140 3%7.0%
70000 w7734 w7627 7402 w7252 ®7.102 366877 36770
75000 367,925 37.756 3%7.39 w7162 36,925 366.568 36339
50,000 3%7.6% %7546 %7.20 67,025 366817 366,504 366,356
85000 37381 367.261 3%7.009 36,802 386,674 366.422 36,300
90000 w7027 36,93 3%6.745 %6618 366.491 366301 36210
9000 366,668 366,606 #6476 366390 36303 #6173 #6112
100000 366,307 386,274 366207 386161 #6115 366,040 #6015
105,000 365949 365,945 %538 %5933 385,927 385920 #5916
105851 365,903 365,903 385903 35903 365,903 385903 35903
10000 365,667 3BEE76 386,692 365,704 #6716 #6722 386,741
15000 35400 #5418 85443 5475 385502 #5532 386,551

120000 385134 365,163 35206 385247 385287 %5310 #5359 ~

oK ( Print... ] [ Help

Symulacja jazdy nowg droga

WejdZzmy w Maps/Render -> Route by Highway (lub na wstgzce Maps/Render -> Route by
Highway), kliknijmy przycisk Segment | wybierzmy nasz plik surey.seg. Nastepnie kliknijmy przyisk
Surface i rowniez wybierzmy nasz plik ze zmodyfikowanym terenem surey2.sup.

Route by Highway [
Files
C:AMDTS Projects\Tutorial06'survey. SEG
CAMDTE Projects’\Tutorial06"\survey2. SUP
Parameters
Initial Station Direction
Final Station @ Direct
Observer Height
Alignment Displacement
[ Interpolate © Inverse
[ Block Corfiguration... ]
[ ok | [ cancel | [ Hep.. |

Wpiszmy w polu Obserer Height warto$¢ 2 oraz w Horizontal Alignment Adjustment wartos¢
1.5. Nacisnijmy OK. Otworzy sie okno z symulacja nowej drogi. Prosze poeksperymentowac z
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parametrami w oknie, przechodzi do przodu i tytu wzdtuz osi drogi, zmieniajac predkosé, kilometraz
czy wysokos¢ obserwatora. Aby zakoriczy¢ symulacje nacisnijmy ESC.

Viewer (E=1fol o)
File Edit View Objects Tools Route Help

OPB P LG B Sy MABIP OO [[EENEE SOW

%Speed 60.0 Station 102.693 Fl} Offset 1.500 U ‘;Hetght 2.000 [V]Relative \

X=335168.654 Y=4084630.053 Terrain=366.029 Height=2.000

Recorriendo Terreno X=335169.077 Y=4084629.783 Terrain height=368.400

Generowanie filmu

W celu stworzenia filmu z symulacji, przejdzmy do Maps/Render -> Generate Video (lub na
wstgzce Maps/Render -> Viewer -> Generate Video). Jesli program poprosi o wskazanie stopnia
kompres;ji filmu, wybierzmy Complete Frames (bez kompresji), wybierzmy nazwe dla filmu surey.avi.
Nacisnijmy OK.
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Files

C:\... \Ejemplo06'topografico avi
C:\.. \Eiemplo0&\topografico2 SUP
C:\..\EiemploD&\topografico. SEG

Parameters
Initial Station ] [ Select Route <
Final Station

Direction
Observer Height _
@) Direct
Alignment Displacement
) Inverse

[ Interpolate
Video

Frequency (mages/sec) Speed (Km/h) 120 -«

Estimated size without compression 156 Mb (14 segs)

[ ok | [ cancel | [ Hep.. |

Aby zobaczy¢ rezultat, nalezy uruchomi wygenerowany plik dowolnym odtwarzaczem wideo
zainstalowanym w systemie, ktéry obstuguje formaty AVI.
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Cwiczenie 9 — tworzenie podioia

W tym przykiadzie pokazemy, jak wykonaé roboty ziemne lub prace wykopaliskowe ze
zdefiniowanego modelu terenu. Czynnosci, ktére wykonamy to m.in. uzywanie nowego modelu i
oryginalnego, obliczenia mas ziemnych za pomocg siatki grid, wizualizacja 3D i przyporzadkowanie
materiatéw do renderingu.

Rysowanie podtoza

Otworzmy rysunek terrain.dwg, ktory znajdziemy w folderze C:\MDT7 Samples\Tutorial09.

Do rysunku wstawimy blok zawierajgcy zmiane terenu, ktérg chcemy wykonaé. Uzyjmy funkc;ji
programu CAD Insert -> Block, nastepnie naciskamy Browse i wybieramy rysunek esplande.dwg z tego
samego folderu. Prosze wstawic ten blok we wspétrzednyh 0,0 ze skalg réwng 1 i katem rotacji O, a
nastepnie uruchomi funkcje Explode (rozbij).

Roboty ziemne do podwyzszenia podtoza

Rzeczg pierwszg i zasadniczg jest uruchomienie przez nas polecenia, ktére spowoduje
zbilansowanie robét ziemnych o oznacza w praktyce, ze ilosci wykopdw i nasypdw beda w przyblizeniu
réwne sobie.

PrzejdZmy zatem do Surfaces -> Earthworks -> by Esplande Height (lub na wstgzce Surfaces
nacisng¢ ikone Esplande Height na panelu Earthworks) i wybieramy polilinie, ktérg przed chwilg
wigczylismy do rysunku. Pojawi sie okno, gdzie mozna skonfigurowac parametry robét ziemnych.
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i Earthwork along subgrade heighl‘ : - M‘
Cument Surface -
D\ \Tutorial09\Terain. SUP
Heights Slopes
Minimum 567.841 Cut [:]
Average 582.397 - [j
Mzdmum 593.473
Subgrade Discretization
[] Target Volume Details 7] Round Comers @
Drawing
fcce Modiy Poirts
@ Calculate Contact Draw Polylines
©) Select Contact [C] Slope drawing
Resutt
Surface Temain2 ‘ File
‘ [ Caleulate Volume e 1.000
Options
Cut Break Lines
[0k | [ cancel | [ Hep.. |
L _— = =

W tym oknie wpiszmy przy Elevation wartosé¢ 580 i wtgczmy opcje Target Volume. Nastepnie
nacisnijmy przycisk Details, co spowoduje pojawienie sie kolejnego okna, ktére skonfigurujemy tak, jak

na rysunku ponizej.

. ,
S

Options
@ Equalize Cut and Fill
© Cut
) Fill

Organic soil thickness
Bulking Coefficient

Maximum Difference of Volume (%)

Calculation Method

() Secuential search
Height Range

Height Increment

@ Fastsearch

10.000
1.000

[

ok | [ cameel ] |

Help

Naciskamy OK. Program zasugeruje wykorzystaé zestaw mozliwych rozwigzan i wybierzemy
trzecig opcje, tam gdzie rdznica jest najmniejsza.
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Volumes

Vol. Fill Volume Cut-Fill Vol. Difference (%)

99941.395 83197.620 11743775 6.24

Zatwierdzamy okno i program automatycznie utworzy nowga powierzchnie o nazwie Terrain2,
a nastepnie zostanie przedstawiona na rysunku z punktami styku.

[ “ 1 Project - tutoriald B
A
/ | [
" AN ’ ‘
N ALK \

< [ Ve o
i / .;__M ,‘.':;" L

TN W= -
ot Frib Fam i
% / \m»ﬂ-,uh—,;ﬂmmmm«ﬂ s e L.
(R L e g .
‘?' ) \‘ \-_-\” RS > |
. \

.t |

Aby podejrzeé zmiany w modelu, uzyjmy narzedzia Quick Profile i utwdérzmy linie z pétnocy na
potudnie naszego rysunku. Powinnismy dosta¢ co$ podobnego do rysunku ponizej. Spdjrzmy, jak

zastosowane zmiany sg fatwo widoczne.
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Separators

Draw...

Horizantal ‘ 50 « ‘ Vertical ‘ T ‘
Profile Slope Height
G || o0 D0 Inial Height
Minimum 0.000
Draw Align. Maximum 149.856 Final Height

601.855
555,563

Minimurn

taximurn

Station: 15.829 Height: 627.925

Vertical Factor ‘

555,563 o,

601.855

7]

0K

306.963

I

Roboty ziemne do podwyzszania terenu

Uzywanie biezgcej powierzchni jako podstawy, wykonamy roboty ziemne, w ktérych poznamy
pofaczenia terenu z granicami podtoza.

Wstawmy blok esplande2.dwg tak jak podczas poprzedniego razu.

Uruchomimy polecenie Surfaces -> Earthworks -> by Terrain Height (lub na wstazce Surfaces

-> Earthworks -> Terrain height) | tworzymy nowa polilinie. Otworzy sie nowe okno, gdzie parametry
podfoza mogg zostac zdefiniowane.

[ Earthwork by Terrain height Li_:hJ‘
Cument Surface
D\ ATutorial09\Temain2. SUP
Heights Slopes
Minimum 580.000 Cut |7l
Average 530.000 = |7‘
T — 580.000 —
Subgrads Discretization o
T - Round Comers |_l
Drawing
LI 7] Modfy Poirts
@ Calculate Subgrade 7] Draw Polylines
Select Subgrade Slope drawing
Result
7| Surface Terain3 | I File... ‘
Calculate Volume
Options
| Cut Break Lines
|> OK I ‘ Cancel | ‘ Help ...
.

W miejscu Esplande Elevation wpiszmy 575, a pozostate parametry zostawmy tak, jak

zasugerowat program.
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Project - tutoriald [=]

| View

{3
AR
" t

Wt

Dodatkowo, jesli uruchomimy narzedzie Quick Profile, mozemy sprawdzi¢ jak wyglada teraz
nasz model.

Quick Profile

Y 5 SNENEN VRN

Separators . _
Horizontal |50 v| Yertical |15 vl [ Draw... Station: -9.720  Height: 621,626
Profile Slope Height E
Average 15.895 . i . Wertical Factor \7
| Save... ‘ Mirimum 0.000 Initial Height 602,501 Minimum 555.479 Length 295,831
Draw Align. M asium 149,871 Final Height ~ 555.479 Maximum B02.501 T|

Roboty ziemne przy zmiennych nachyleniach

Ponownie wykonamy tutaj roboty ziemne, lecz tym razem zdefiniujemy inne nachylenia w
zaleznosci od strony polilinii, ktora okresla nasze podtoze. Wstawmy blok Esplande3.dwg.

Przejdimy do Surfaes -> Earthworks -> By esplande height i zaznaczamy polilinie, ktdra
wtasnie utworzylismy. Ustawiamy Elevation na 557, po czym przechodzimy dalej.
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=
Earthwork by Terrain height

Cument Surface

D\ ATutoral 094 Temrain3.5UP

Heights Slopes

Minimum 544 456 Cut @

Average 550.944
M Fill 1.500
o -

Fiirait 557 Discretization 10.000

[7] Target Volume Details ... (" Round Comers

Drawing
Mod
2es Modify Poirts

(@ Calculate Subgrade Erew Poblinies

() Select Subgrade [ Slope drawing

Result

Surface Temaind | File...
| [ Calculate Volume Cell Size 1,000
| Options

Cut Break Lines

[ ok | [ cancel | [ Hep.. |

L

Pojawi sie okno, w ktdrym mozemy ustawi¢ wartosci nachylen w stosunku do strony polilinii.

W miejscu wykopu, wstawiamy wartos¢ 0.667 dla potudniowego i pétnocnego odcinka oraz

1.5 dla wschodu i zachodu.

W miejscu nasypu, wstawiamy wartosé 0.5 dla pétnocnego i potudniowego odcinka oraz 1 dla

wschodniego i zachodniego.

Slopes ¢ Pas . . [ =
Assigned slopes Preview
1.500
New
o4
Wykop

Slopes ¥ .en -
Assigned slopes Preview
pi——

1.000
New
i
Nasyp

Ostateczny wynik zostat zaprezentowany na ponizszym rysunku.
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Wycieczka po terenie

Wezmy teraz wirtualng wycieczke po naszym terenie. Przejdzmy do Maps/Render -> Route by

Terrain (lub na wstgzce Maps -> Viewer -> Route by Terrain), wskazujemy plik terrain3.sup oraz
ustawiamy wysokos¢ obserwatora na 50.

Route by Terrain

DA\..\Tutorial09\Terrain3.SUP

Route Height

)

() Absolute

v+ [100.000
Height U0, 000

Obserer He
[ OK ] [ Cancel ] [ Help ... ]

@ Relative

Naciskamy OK i otworzy sie nowe okno z symulacja.

Gt View Obpects Took Rowte Hap
BPO P wg @S M E )P NN E SOW

regh 3L7% [V Reatve

Recoriends Terenc

X TFBAL7 567 V4085085 123 Terrin height=543.287
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C'Wiczenie 10 = Osie drog

W tym ¢wiczeniu wyttumaczymy podstawowe narzedzia stuzgce do obliczania parametréw osi
drog.

Na poczatku otwérzmy plik  alignments.dwg znajdujagcy sie w folderze C:\MDT7
Samples\Tutorial10. Na rysunku s3 dwie biate linie reprezentujgce droge oraz kilka linii prostych i
tukéw, ktdére wykorzystamy do stworzenia nowej osi drogi, ktdra w przyblizeniu bedzie przebiegata w
srodku istniejgcej drogi.

Nastepnie uruchomimy polecenie Elements -> Calculate i wybieramy tuk po naszej lewej
stronie. Pojawi sie nowe okno, w ktérym znajda sie elementy, ktére wykorzystamy do stworzenia
naszej osi drogi.

Alignment Calculation ‘ R |

Speed: 80.000 Instruction: #

Tope Radius a1 a2 X(P1) YiP1) X(P1) X(P2) Setback i

» | Fized 2P1F ~ -95.000 0.000 0.000 418405.354 4167131367 418433665 4167135.244 0.000
| Insertbefore |
————
Down
"< v\ Elements {Alignment / | « (0 [ Fix
l Open... I l Save... I [ Draw ] l AL [V] Calculate { oK ] [ Cancel ] [ Help

Nacisnijmy przycisk Insert after aby dodac kolejny element po juz istniejgcym.
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Type Fixed 2P1R [two points one radius |l d 0K,

Naciskajac przycisk < zaznaczamy linie, ktéra pojawi sie w kolejnym kroku na rysunku.

| Alignment Calculation |i ‘\
Speed: 80.000 Instruction: - Al A2
Type | PRadus | &1 | a2 | xPU | YPU | XP1) | XP2 | Setback | ™
# Fized 2P1R [tw -95.000 0.000 77.832 418405354 4167131.367 418433665 4167135.244 0.000 =
L2 Fixed 2P1R [t 0.000 0.000 0.000 418516.995 4167191.637 418540181 4167210674 0.000 [6esi belote
Delete
Inzert after
Down
Invert
"< v\ Elements {Alignment / |« 1 b Fir
[ Open... I [ Save... ] [ Diraw J [ AL ] Calculate [ ak ] l Cancel l l Help
. J

Program automatycznie obliczy parametry klotoidy pomiedzy linig a tukiem i wyznaczy
przydzieli parametr A2 (klotoida wychodzaca) do osi nr 1.

Teraz zaznaczymy o$ nr 2 poprzez nacisniecie jej numeru w pierwszej kolumnie. Pojawi sie
strzatka potwierdzajgca selekcje. Naciskamy Insert after, na liscie wybierzmy Rotating element na OK.
Na liscie pojawi sie trzeci element zaznaczony na czerwono, co oznacza, ze nie zostat jeszcze
przeliczony.
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Alignment Calculation [ = ]
Speed: 80.000 Instruction: - Al A2
Type Radius A1 A2 H(P1) Y(F1) X(P1) X(P2) Setback i
1 Fized 2P1R [tw -95.000 0.000 77.832 418405354 4167131367 418433665 4167135.244 0.000 =2
2 | Fixed 2P1R [bw 0.000 0.000 0000 418516.995 4167191.637 418540181 4167210.674 0.000 Isat Darain
B Feetine 0.000 0.000 0.000 0.000
Delete
Insert after
Down
Inwvert
<} \ Elements {Alignment /* <] [ | ) Fix
[ Open... ] [ Save... ] [ Draw ] [ Al J Calculate [ akK ] [ Cancel ] [ Help ]

,
2

Naciskajagc na odpowiednig komdrke w kolumnie X(P1) wyznaczamy centrum okregu
znajdujgce sie na gornej krzywej i wpisujemy promien 45. Powyzej, na liscie rozwijalnej Instruction,
wybieramy grupe nr 2, a po prawej stronie naciskamy przyciski A1A2, aby przyporzgdkowaé parametr
klotoidzie.

T —
Alignment Calculation ‘ &= 1
Speed: 80.000 Instruction: - Al A2
Type Radius A1 A2 X(P1) Y(P1) X(P1) K(P2) Setback
1 | Fixed 2P1R (tw -95.000 0.000 77.892 418405354 4167131.367 418433665 4167135.244 0.000 —
2 | Fixed 2P1R [tw 0.000 0.000 0000 418516995 4167191.637  418540.181 4167210.674 0.000
» | Rotating 45.000 0.000 0.000  418631.652 67277.326 0.000
[‘ own
<1\ Elements /Alignment / |« I | ) Fix
[ Open... ] [ Save... ] [ Draw ] [ Al ] [V] Calculate [ K ] [ Cancel ] [ Help ]

Zaznaczamy element nr 3 i naciskamy Insert After. Wybieramy linie prostg. Powtarzamy proces
z elementem nr 4, wybierajgc tuk. Program automatycznie oblicza klotoidy, co sprawia, ze mozliwe jest
dalsze projektowanie osi.
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Alignment Calculation [= ‘
Speed: 80.000 Instruction: - Al A2
Type Radius Al A2 X[P1) YIF1) XF1) X[P2) Setback 7
1 | Fized 2P1R [tw -95.000 0.000 77.892 418405354 4167131.367 410433665 4167135.244 0.000 =
2 | Fined 2F1R [tw 0.000 0.000 0.000 418516995 4167191.637 418540181 4167210.674 0.000 [raertbeiore
3 | Rotating 45.000 0.000 48.320  418631.652 4167277.326 0.000
4 | Fized 2P1R (v 0.000 0.000 0.000 418693508 4167258155 418729.309 4167240.316 0.000 Delete
5 | Fired 2F1R [tw 97.727 47.190 0.000 418781775 4167216193 418806129 4167212378 0.000 T
isert afte
Down
Irvert
< v\ Elements /Alignment / <= T 3 b Fix
[ Open... ] [ Save... l [ Draw ] [ AL [V] Calculate 0K ] ‘ Cancel ] l Help

Po elemencie nr 5, uzywajgc opcji Insert After, wybieramy z listy Floating i naciskamy OK. W
celu utworzenia elementu mobilnego, pozostate elementy musiaty zosta¢ ponownie obliczone.

Uzywajac opcji Insert After, tworzymy tuk. Mozemy zauwazy¢ w rysunku, ze mobilna linia
zostata przekalkulowana, co jest dla nas efektem niepozgdanym. Wstawimy zatem promien na 400, co
jest lepszym wyjsciem.

H\\
s
Alignment Calculation ‘ = ‘
Speed: 80.000 Instruction: - A1 A2
Type Radius A1 A2 X[P1) Y(P1) PN | RIP2) Setback
1 Fized 2P1R [t -95.000 0.000 77.832 418405354 4167131367 418433665 4167135244 0.000 B
2 | Fized 2P1R [tw 0.000 0.000 0000 418516935 4167191637 418540181 4167210.674 0.000
3 | Rotating 45.000 0.000 48.320  418631.652 4167277.326 0.000
4 | Fized 2P1R [tw 0.000 0.000 0000 418693508 4167258155 418729303 4167240.316 0.000
5 | Fized 2P1R [bw 97727 47.150 0000 418781775 4167216193 418806129 4167212.378 0.000
» | Floating 400.000 0.000 0.000
7 | Fized 2P1R [bw 139.853 0.000 0000 418333336 4167197.829  418376.080 4167173632 0.000 Dawn
< » ' Elements .(Align ment ;/ | < | T » Fix
[ Open... ] [ Save... ] [ Draw } [ AL } [V] Calculate 0K ] [ Cancel ] [ Help l

Podswietlajac element nr 7 wciskamy Insert After i wybieramy z listy Rotating i ustawiamy
promien na -40, co sprawi, ze fuk zostanie przedstawiony z lewej strony. Naciskamy réwniez przycisk
A1A2, aby wyznaczy¢ rowniez klotoide dla tych tukéw.

W kolejnym elemencie wstawiamy (Insert after) linie prostg. W tym momencie os$ drogi jest
przeliczana i po nacisnieciu OK pojawi sie nowe okno, gdzie mozna nazwaé¢ nowg o$ i wprowadzic¢
kilometraz poczgtkowy.
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| Convert to Alignment ) |ir
Name  |Alignment1 |
Station Length: 751537
Instruction
Sped K
Category | Grupo I: Carreteras 80 . 60 y 40 ~|
[ Insert curved sections between straight lines Eadis
[ Export to file
Dimension Alignment
0 (=] B
« ./
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C'Wiczenie 11 = Skrzyzowania

W tym ¢wiczeniu zajmiemy sie opisem narzedzi stuzgcych do automatycznego budowania
skrzyzowan miedzy drogami. Wszystkie pliki potrzebne w tym projekcie zawarte sg w folderze C:\Mdt7
Samples\Tutorial11.

Do stworzenia skrzyzowania, MDT przyjmuje dwa rodzaje drég: Droga gtéwna, ktdra jest
niezmienna oraz Droga drugorzedna, ktéra zostanie zaadaptowana do stworzenia odpowiedniego
skrzyzowania.

Dodatkowo, warto zaznaczy¢ opcje Draw in 3D znajdujgcg sie w Utilities -> Configuration
Surfaces, w celu wygenerowania lepszej wizualizacji w pdZniejszym czasie.

[‘Surface Configuration F5)
Layers
Sufface [SRF-TRIANGULATION I I
Boundary  [BRK-BOUNDARY | [
Islands [ERK-ISLANDS | (L]
Break [BRK-LINES i I
Parallels [BRK-PARALEL I I
Parameters
Maximum Side Length {m)
Minimum Distance between Vertices {m)

| Max. Dist. between Vertices and Points (m)

I Representation

| [¥]Draw Suface in 3D
[/] Draw Break Lines in 3D
Line Scale Edition coler

( Break Line Coding... ]
|l Modified... ] Earthworks... ] il
[ ok ] [ cancel | [ Hep.. |
L

Nachylenie zaadaptowane do skrzyzowania

Przed rozpoczeciem tworzenia skrzyzowania, konieczne jest zaadaptowanie nachylenia do
drogi, gdzie nastgpi skrzyzowanie. Przejdzmy do Profiles -> Draw Compound Profile, a nastepnie
zaznaczamy plik secondaryroad.seg.

TcpMDT ver. 7 — Podrecznik uzytkownika
Ustugi Informatyczne SZANSA Spoétka z o.0. z siedzibg w Bielsku-Biatej przy ul. Chryzantemowej 5, 43-300 Bielsko-Biata zarejestrowana w Sadzie Rejonowym w
Bielsku-Biatej, VIII Wydziat Gospodarczy Krajowego Rejestru Sadowego pod numerem KRS 0000536210, z kapitatem zaktadowym 50.000 ztotych. NIP
9372672769, REGON 360604756. Wszystkie prawa zastrzezone.



accesoentrada?

175.00 17500
o _
) o -1 — = D
TTTT 17171

170.00

5 z g 2 & X & o = g = ] g

o o™ = - - - - - L'<) - L] - (=5

8 8 8 8 B &8 8 8 8 B 8 8 &

e ¢ RE ® R B 2 B B B

Zdefiniujemy teraz wczesniejsze nachylenie za pomocg polilinii w taki sposéb, ze bedzie ono
zaadaptowane do naszego profilu podfuznego w rejonie skrzyzowania. W naszym przypadku, pomiedzy
dwoma czerwonymi kétkami zaznaczonymi na profilu.

Uruchamiamy polecenie Grade Lines -> Convert grade line from polyline.

175.00 175.00

] Bl D
P.C 17000 ‘m(
170.00

- 3 @ = - =+ - = = o] o [v] el
& N = £ 2 = ¢ = & 9% n £ BE5
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= = = = N = = = = = = - s
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= = g £ R i g & ] i o

Dla ufatwienia wykonywania ¢wiczenia, to nachylenie zostato zdefiniowane juz wczesniej,
dlatego mozemy importowaé je z pliku obserwujgc jak adaptuje sie do profilu podtuznego w
przecieciach z gtéwng drogg. Wybierzmy Gradient -> Import i wybierzmy secondarygradeline.ras.

V= CONVEX
IS ST=29.999
- Zv=172.808
g Kv= 381.973
& T = 9.880
A d =D122 a
i
175.00 i . 175.00
- s
P.C. 170.00
170.00
B § 8 B 58 & B 2 g 8§ E B B
o™ o™ o o™ o™ o o™ o o o o o o
= = = = = = = = = = = = &
E E E B B BE E BE E EBE B B H
" woe Ee 8 & 8 & g g 2 & =
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Po zdefiniowaniu pochylenia, wprowadzimy je do segmentu. Wejdimy w Segment ->
Define/Edit i wybieramy secondaryroad.seg. Importujemy do zestawu nasz plik z nachyleniem (do

rubryki Grade Line).

[ Segment definition - [C\MDTY Projects\Tutorial11\SecondaryRoad.SEG]

Components
Element File Initial Station Final Station Date =
ALIGNMENT SecondaryRoad EJE 0.000 £1.033 03/09/14
PROFILE SecondanRoad LON 0.000 £1.033 03/09/14
CROSS-SECTIONS SecondanRoad TRA 0.000 £1.033 03/09/14 =
GRADE LINE SecondanyGradeline....  0.000 £1.033 22/05/14
WIDEMINGS
TEMPLATES SecundaryRoad SCC 99,914 100.000 03/09/14
SUPERELEVATIONS
BLOCKS -
’ Impoit.... | I Automatic Select. Export... } I Delete
Yiew / Edit... ‘ List. Print Recalculate B
Optionz Preview
[ Werify... ] Generated without errors
’ Check... 1 I\-"olumes Heport...J
| Draw. | | Modiied.. | — et
I Top view Export routing
’ Feport ’ E] E]
’ (1] ’ [ Cancel Help

Skrzyzowanie drég

Otworzmy rysunek survey.dwg znajdujacy sie w folderze C:\Mdt7 Projects\Tutorial11.

Aby by¢

doktadnym, stworzymy skrzyzowanie w miejscu wskazanym na rysunku.
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Uruchamiamy polecenie Surfaces -> Get Modified Terrain,

wybierajac

plik

secondarylinkroad.seg. Zmieniamy Final Station na 160, a reszte parametréw jak na rysunku ponizej.

-
Get Mcdified Terrain

S5

Limits

Drawing

[T Points

[¥] Cross-Section Lines
[7] Blocks

["] Cross-Sections

[] Slope Drawings
Cut Break Lines
Result

Initial Station 0.000
Final Station

Height
) Sail

@ Roadbed

[V] Surface survey2.SUP |

Options
[ Interpolate
[7] Use Islands

[¥] Zoom to Temain

[T Recalculate Natural Temain

[ oK

] [ Cancel ] [ Help ... ]

Po zatwierdzeniu okna, rysunek bedzie wygladat podobnie do przedstawionego ponizej. Teraz
wystarczy, ze stworzymy skrzyzowanie na oby trasach.

Aby utworzy¢ skrzyzowanie, wejdZmy w Segments -> Road intersection i wybieramy plik
mainroad.seg, a nastepnie secondarylinkroad.seg. Pojawi sie ponizsze okno, w ktdrym musimy wybrac
rodzaj skrzyzowania — wybieramy obrazek z lewej.
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Intersection height
@ Roadbed

Program zapyta nas o punkt skrzyzowania i my wybierzemy jakikolwiek punkt znajdujacy sie w
rejonie, gdzie nasze skrzyzowanie bedzie wystepowato. Po wybraniu punktu, pojawi sie ponizsze okno,
w ktorym ustawimy parametry skrzyzowania. Ustawmy parametry jak na ponizszym rysunku. Prosze
zwréci¢ uwage na sekcje Intersection zone i ustawié¢ parametr Secondary(SE) na 30.

- _
e ==
tain Connection Outer Hard Shoulder -
Foads — . : Intersection Zone
ain Alignment - —
C:\.. ATutoriall 1\MainRioad SEG Main (FE1] 20,000
Secondary Alignment Main [PE2] 20,000
C:h ASecondaryLinkRoad SEG
|| itersection Secondary [SE) 30
o g
A Secondary 183281
Link 1 [B1) Link 2 [B2]
- - Section T 2 :
Type [Llne - Curve - Line v] Bl vpe [Llne - Curve - Line vJ
R adius 15.000 Cut Slope Fill Slope Radius 15.000
— i 1.000 Mai 1.500 e
[oooo | Mk an [Doon |
[b—. 0 | Secondary  1.000 Secondary 1,500 |7ﬂ T |
Calculate Links
Discretization interval 0.500 .
Secondary Connection | Outer Hard Shoulder « Secondary Connection  Outer Hard Shoulder +
[ Dewlikl | [ Drawlink2 |
> Yolume f
.
[ Calculate Cell Size 1.000

[ Calculate Intersection ]

Nacisnijmy przycisk Calculate intersection, po czym mozemy obserwowac, jak skrzyzowanie
jest budowane. Po skoniczeniu program zapewni nam mozliwos¢ cofniecia zmian, zmiany parametréw
lub przerwania procesu. W naszym przypadku przerywamy proces i naciskamy ENTER.

Dwa ponizsze rysunki przedstawiajg nasze skrzyzowanie z dwéch réznych widokow.
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110 Wihane]

satem Vew] 0 W]
\

warstwicami.

To samo skrzyzowanie moze zosta¢ wyswietlone z warstwicg o réwnym cieciu 0.5 m miedzy

e
'Iz 4 il ,
&;’; = s 7
Pas wtaczania do drogi
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Aby stworzy¢ tego typu potaczenie dwdch drog jak pas wigczania sie jednej drogi do drugiej,
uzyjemy segmentu lub drogi, ktérg zdefiniowalisSmy na poczatku ¢wiczenia.

Na poczatku, wejdZmy w Surfaces

-> Get modified terrain i zaznaczamy plik
secondaryroad.seqg. Wprowadzamy kilometraz koricowy 21. Inne opcje wstawiamy tak jak na rysunku
ponize;j.

[ ==

Efekt korncowy powinien byé podobny do rysunku ponizej. Mozna zauwazy¢ jak powstaje
potaczenie podczas wykonywania polecen przez program.

Tak jak w poprzednim skrzyzowaniu, wybierzmy polecenie Segments -> Road Intersection.
Wybieramy plik mainroad.seg jako gtéwng droge oraz secondaryroad.seg jako droge drugorzedna.
Program zapyta nas nastepnie o Intersection start point, gdzie zaznaczamy punkt w poblizu

niebieskiego znacznika na powyzszym rysunku. Po wskazaniu punktu, pojawi sie nowe okno, w ktérym
nacisniemy tym razem obrazek z prawej strony.
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Po wybraniu typu skrzyzowania pojawi sie nowe okno, w ktérym zdefiniujemy parametry,
ktore nastepnie zostang wziete pod uwage przez program podczas tworzenia nowego potaczenia drég.
Ustawmy opcje tak jak na rysunku ponizej. Dodatkowo, mozemy réwniez zaznaczy¢ opcje Calculate

Volumes, aby po utworzeniu potgczenia, nastgpito obliczenie objetosci mas ziemnych w nawigzaniu
do nowoutworzonego fragmentu drogi.

Main Canrechon Lanel ".
Sechon
[¥] Check Slapes
Cut Siope Fill Slope:
Main 1.000 Man 1.500

Seconday 1500 Secondsy 1500

Irrervalo Disceetizacitn 0500
Walume

] Calculate Call Sizes 1.000

Program zapyta nas teraz czy chcemy cofng¢ tworzenie pofgczenia drég, by np. zmienic
parametry potagczenia. Mozemy réwniez zatwierdzi¢ zmiany jesli s3 one poprawne.

Mozemy teraz wyswietli¢ efekt naszej pracy generujgc cyfrowy model terenu za pomoca
polecenia Maps/Render -> Route by Terrain.
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CWiczenie 12 = Obliczenia geodezyjne

Celem tego ¢wiczenia jest konwersja pliku utworzonego w terenie, obliczenie wspétrzednych
punktow i stanowisk, wyréwnanie ciggu poligonowego i transformacja wspotrzednych.

Na poczatku, wejdZmy w polecenie konfiguracji Utilities -> Configuration, nacisnijmy przycisk
Surveying i w menu Mode wybierzmy Beginner. Zaakceptujmy zmiany.

Coopewsy
Goaﬂanh;mmm(%‘l
@ Local
Froited
Comections Adimiasble Evors
7| Sphericty and Refraction Detance s 0010 |
L : Height men) 0.010
B dege  [00020
. Haszootal (1) 10000 |
: o Wertical {1.X) 10000
Distay Ingpt
Ditarce Vtical st et
& Feduced @ Vetical Angle @ Total Slason
Height DWF .
Gaeormastric: | Oheck Vbl Angle Tachymeter
e - | Tatée of ratnaments |
' [ Least Squanes |

Konwersja pliku z terenu

Pierwszym krokiem to wykonanie transformacji pliku z tachimetru lub z rejestratora polowego.
Wybierzmy Surveying -> Import. Wybierzmy producenta TCP, wybierzmy format Levantamiento ASCII
i wybierzmy plik network.lea w folderze C:\MDT7 Samples\Tutorial12. Zaznaczmy réwniez trzy opcje
w sekcji After Converting.
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Convest Survey File

Mamdfacturer
Topcan
Lica

(]
Mods=l

Levantamienic 008

Nikoon
Pertax
Saokdda

After Conventing

| Check Dbsenvations

o Import Survey

o Go to Station calculation

Zaakceptujmy zaproponowang nazwe oraz opis. Pojawi sie okienko, w ktérym mozna przejrze¢
importowane obserwacje oraz modyfikowad je. Nacisnijmy OK.

Mot Stalion

]

HD
B0 59144

Stake Code
1310
110
1.310
1.310
1318

L

40

W0 S0 - S BN f LS RS = O e D

Obliczanie wspoétrzednych

Mozemy teraz przejs¢ do obliczania stanowisk oraz pikiet. Lista w lewym-gérnym rogu tj. Origin
Station odwotuje sie do stanowisk, na ktérych stawialiémy instrument w terenie. Przejrzenie tej listy
da nam oglad ile pikiet zostato zmierzonych, jakie byto nawigzanie, jaka byta wysokos¢ instrumentu
oraz jakie stanowiska byty mierzone z danego punktu. Na przyktad, dla stanowiska nr 1 pomierzono
pikiety 1-189, dodatkowo pomierzono w kierunku tam i z powrotem stanowisko 2,5,6, a w jedng strone
tylko 3,4 — informacja ta zawarta jest w sekcji Stations, gdzie np. D2 oznacza ze stanowisko 2 zostato
pomierzone dwukrotnie. Prosze zobaczy¢ inne stanowiska i zorientowad sie jak przedstawiat sie
pomiar.
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Mozemy edytowac lub wyswietli¢c stanowiska i obserwacje w prosty sposdb. Nacisnijmy
przycisk Observations znajdujacy sie w sekcji Stations i w oknie, ktdre sie pojawi, lista pomiaréow
dotyczacych stanowisk instrumentu. Oczywiscie mozliwa jest edycja kazdej wartosci. Aby zobaczy¢
podobna liste z obserwacjami do punktéw, nalezy nacisngé przycisk Obserwations w sekcji Points.

==

.—! o R

o XI5 300
154 3291500
3 335.4380
181 5460
78840
00000
183370

106.2460

v s i O
B EE B
[ERERE e

£E

EREECET

SOoCommoo
f=Boiiol
253

g m

et G B ] G e 00 ]

=

100.0600
1017320

ARES

of ¥

{

"Edit Point Obsarvations .
Station: 1 Instrumant Height 1525
T Mum. Hor Angle Vet Angle Network  Stake Code

2374880
241.4100
250.3380
273.8820
346.0920
371320
1.5100
g 7.7140
5 105500
125300
13.3880
12 140020
12 9440
12.2540
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103.8540
03630
1030060
01 0340
5§5.5420
55,4580
95.3720
56.8B50
57,3400
57.7380
58.0000
56.1500
98 2720
58.1060

47 500
36220
23.730
13.330

2030
2050
2030

| BEEEEENEREE

ok ]

Kolejnym krokiem jest przypisanie wspétrzednych, zaczynajac od stanowiska poczgtkowego (nr
1). Zaznaczmy to stanowisko i nacisnijmy Assign. Wpiszmy X = 300000, Y = 4000000, Z = 100.
Nacisnijmy OK. Zauwaimy ze opcja Fixed jest teraz aktywna. Wspodtrzedne pojawity sie w sekcji
Calculated Coordinates.
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| Coordinate Assignment [
Station of Origin: 1
Coordinates
X (300000 |
Y _ADDUDDCI

z [100.000

Initial Horizontal Comection 0,0000

o =T R v

Teraz przystgpimy do obliczenia wspotrzednych wszystkich stanowisk i pikiet. Na samym
poczatku musimy poinformowac program, ktére stanowisko jest poczatkowym (u nas jest to 1).
Zaznaczamy 1 i wybieramy opcje Origin. Pojawi sie przycisk Automatic.

Station Calculation (]
Stationaf% i Instrument Setups Stations
2 *  InstrHght. HorzCom.  Points New -
3 S 525 00000 1189 PM
2 4 51
6 , o l|[CE: -
; { Instrument Setups... J - ]
9 T Points
(V] Origin V] 5et [ Coordinates. .. ] [ Observations... | Observations... ]
[ Projected
Methods of Coordinates Calculated
Observation Station X Coord. Y Coord. ZCoord. Observations
| Manual . J
’ Twemes eD: 0.000 eX: 0.000 eY: 0.000 eZ: 0.000
S Assign ... Average | Deete | DelteAl |
[ Daw. || Configuration... | [ cancd | [ Hep.. |

Nacisnijmy przycisk Automatic, aby pokazac raport z wynikami, gdzie zawarte bedg obliczone
stanowiska, uzyte metody obliczen, btedy, wysokosci, odlegtosci, katy. Gwiazdki obok poszczegdlnych
wartosci oznaczajg, ze zostaty przekroczone maksymalne odchytki. Nacisnijmy OK, przez co
wspotrzedne zostang przyporzagdkowane do poszczegdlnych punktéw.
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Results of Automatic Calculation ﬁ
Method Base Station Approved Station Dist.Enm. Hght .Err. Angle Emor
Double Observation 2 1 0.002 0.012* 0.0000
Double Observation 3 2 0.005 4.008 0.0000 —
Double Observation F | 2 0.003 £031* 40.0000
Double Observation 9 7 0.001 40.005 40.0000
Double Observation 9 4 0.003 £0.009 0.0339
Double Observation 4 3 0.003 Q011" 0.0030 |-
Double Observation 5 1 0.003 0.010* 0.0000 |~
Double Observation 5 8 0.006 0.010 0.0304
Double Observation 8 2 0.004 0.009 0.0423
Double Observation 8 10 0.013* 0.006 0.0553
Double Observation 1 8 0.010 0.011° <0.0000
Double Observation n 10 0.012* 0.004 0.0243
Double Observation 12 n 0.003 0.009 0.0000
Double Observation 13 2 0.002 0.007 0.0000
Double Observation 13 6 0.009 0.000 4.1684
Double Observation 6 1 0.001 0.021° 0.2474
Double Observation 14 12 0.000 -0.009 -0.0000
Double Observation 10 16 0.002 0.003 0.0254
Double Observation 10 4 0.014* 0.001 01955 ~

[[OK | [ Cancel | [ Hep.. |

Mozemy sprawdzié, ze wszystkie stanowiska zostaty zorientowane. Nacisnijmy Instrument
Setups i pojawi sie okno, w ktérym zobaczymy wysokosci instrumentéw oraz nawigzania.

=3

Station  InsirHght, HorzCom.  Points

1 1.525 00000 1-183
2 1.540 135.3800 190-229, 231-245 =
3 1545 118.7520 246-391

7 1540 446260 352432

5 1610 1351060 433477
4
5

»

m

1.505 218.0670 478-561
1.570 181.5460 562.582

8 1490 1427237 583-608

n 1460 1363677 605666

12 1575 2305437 667696 [
13 1445 2305057 697-789

& 1.500 207.8055 -

14 1585 2365697 790-833

10 14%0 1243835 334872 o

| Edt.. | [ New. || Deiete || Rename | [ Renumber |

[ Sort | | Print... |
OK | | Cancel | | Hep.. |

)

Wybierajgc inne stanowiska, mozemy zobaczy¢ obliczone wspéirzedne jak poprzednio.
Wybierzmy stanowisko nr 8. Mozemy zobaczy¢, ze w sekcji Coordinates Calculated pojawity sie
stanowiska 2, 5, 10, 11. W pézZniejszym czasie poznamy inne metody obliczen, ktére pomogg nam
zrozumiec te procedure uzyskiwania wspoétrzednych. Jesli chcemy, mozemy sprawdzi¢ wspdtrzedne
stanowisk naciskajac Coordinates w sekcji Stations.
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FMName  XCood.  YCood.  ZCoord. Scale Code
F1 300000.000 _4000000.000 _100.000 __1.00000000 R
2 299949759 4000031202 97563  1.00000000 T
3 299915882 4000041455 95009  1.00000000

4 299855320 4000030.098 92523  1.00000000

5 299989.127 4000035783 100746  1.00000000

6 300011.983 4000095712 102278  1.00000000

7 299922651 3999939.084 96724  1.00000000

£ 299962808 4000056869 97.739  1.00000000

9 299843090 4000048021 91404  1,00000000 -
10 299847406 4000119.451 92684  1.00000000 -
11 299896.409 4000099547 94.348  1.00000000

12 299909.699 4000124701 96158  1.00000000

13 299927418 4000158.795 97.725  1.00000000

14 299867.153 4000150013 92302  1.00000000

15 299890544 4000182284 96.055  1.00000000

16 299853326 4000187.823 94622  1.00000000

17 299899.805 4000201253 98.932  1.00000000 £
18 299841537 4000234263 95515  1.00000000

19 299905465 4000241.940 104.40¢  1.00000000 i

[ Edt. | [ MNew. | [ Delete | [ Set | [ Moble | [ Pame | Froeced
| SeectAl || Ceard || ReadDrawing | | impot.. || Bpot.. || Pint..

(oK ] [ cancel | [ Heb.. |

Punkty réwniez majg przyporzgdkowane wspotrzedne. Aby je wyswietli¢ nacisnijmy przycisk
Coordinates w sekcji Points.

Station: 1 Instrument Height: 1.525

Y Coord.

3999560.500
3999971.176
3999983.267
3999994 683
4000006.557
4000014.293
4000025.552
4000044184
4000055.642
4000079.691
4000093.865
4000107048
4000108.943
4000095.837
4000083.788
4000070.871
4000055.746
4000044050 101.474

4000028523 100.970 ¥

(oK ) [ Ewot.. |[ Pat. |[ Hep.. |

ZCoord. Code
96.556 -
97.366 =1
98.311 =
99.218
100.071
100.478
101121
101.614
101.963
102.324
102.452
102 555
102.456
102341
102.202
102.015
101.723

Rysowanie stanowisk i punktow

Teraz mozemy wrysowac¢ ha mape nasze obliczone punkty. Dla stanowisk, w oknie Station
Calculation nacisnijmy przycisk Draw. Nastepnie naciskamy Stations oraz Station Observations. Na
koniec naciskamy OK.
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Draw A @‘

Stations

Station Observations

Points...

| Cancel | | Hep..

Mozemy zobaczyé, co nam sie wrysowato na mape. Punkt nr 1 ma symbol tréjkata, pozostate

za$ maja forme okregéw (s to obliczone stanowiska). Zétte linie oznaczajg podwdjne pomiary,
czerwone zas, pojedyncze.

Aby wrysowac punkty, ponownie wchodzimy w Station Calculation, ale tym razem naciskamy
Draw -> Draw Points z opcjg All i naciskamy OK.
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W nastepnym oknie modyfikujemy parametry rysowania punktéw. Ustawmy skale 1:500, a

reszte opcji zostawmy bez zmian. Nacisnijmy OK.

Mozemy teraz przystgpic¢ do tworzenia mapy.
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Pozostate procedury obliczen

Modut Survey (Obliczen geodezyjnych) pozwala réwniez na wiekszg kontrole na
przeprowadzanymi obliczeniami. WejdZmy do narzedzia Station Calculations i zaznaczmy stanowisko
nr 1 w sekcji Stations of Origin, natomiast w sekcji Stations zaznaczmy D2. Teraz nacis$nijmy przycisk
Manual. Program pokaze nam obserwacje z punktu 1 do 2 i z 2 do 1. W nowym oknie pojawi sie
informacja na temat poszczegdélnych pomiarédw odlegtosci, réznic wysokosci i odpowiadajgcych im
roznic.

Information |

Base Station: 1 Approved Station: 2

Cestances Height Diff.’s
Forward 55.144 -2.445
Backwards 55.140 2425
Average 55.142 2437
Errors 0.002 0.012

Horizontal Comection: 1353800
|, Edt.. ‘|

[ ok | | Cancel | | Hep. |

Wybierzmy teraz Surveying -> Utilities -> Reverse Intersection. W oknie wskazmy stanowisko
nr 8 | nacisnijmy OK.

Instrument Setup Selection Exe

Instrument Setup
3 1.545 246391 -
7 1.540 392432
91610 433477 =
4 1.505 478-561
5 1.570 562-582

81490583608
11 1.460 609-666 «

| 0K | | Cancel | [ Hep..

Wybierzmy metode Angles and Distances oraz 3D w sekcji Options. Prosze zaobserwowac
reprezentacje katowg w nawigzaniu do pozgdanych stanowisk, elipse btedu oraz wspétrzedne
stanowiska 8. Nacisnijmy OK.
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Inverse Intersection

Station 8

Method Ogtions
Only Angles 20
Only Distances

@ Angles and Distances @ 30

Result Eliipse Emor

X 299962797 Su: 0.0084

Y: 4000056.834 Sv: 0.0070

Z: 97747 I: 393.4237

HC: 1427348 E: 0.01

299896384 4000099 523
299847 406 4000119451

Ponownie uzyjmy narzedzia Station Calculations i zaznaczmy stanowisko nr 8 jako stanowisko
poczatkowe, mozemy zobaczy¢ jak bedzie wygladata nowa sie¢ dla obecnych wspétrzednych.
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éWicze n ie 1 3 = Ciagi poligonowe

W ¢wiczeniu nr 12 wykonywalismy obliczenia geodezyjne, aby uzyskaé tymczasowe
wspotrzedne dla naszych stanowisk. Te punkty zostang teraz przeliczone w sposdb precyzyjny z
uzyciem ciggu poligonowego. W naszym przypadku najbardziej optymalnym rozwigzaniem bytoby
wyrownanie sieci katowo-liniowej, lecz mozemy réowniez dokonac przeliczenia wspotrzednych ciggiem
poligonowym dla poszczegdlnych czesci.

Na poczatku przejdZzmy do Utilities -> Configuration -> Surveying -> Least Squares i zaznaczmy
opcje znajdujace sie w sekcji Control tests. Reszte parametréow zostawmy bez zmian.

| .

Maximum lterations Corfidence Level

© 0%

Convrerce e .

[ %
Hlipse Scale 99

Quality control tests
Intemal reliability test (Baarda)
(V] Goodness fit test (Chi2)

[ ok | | Cancel | [ Hep.. |

PrzejdZzmy do Surveying -> Traverses. Na liscie Survey w sekcji Station wybierzmy stanowiska
1,5, 8,11, 12, 13 i 6 w tej kolejnosci. Pojawi sie opcja Set Source, ktorg zaznaczmy oraz zaznaczmy
rowniez Closed. Nacisnijmy przycisk Compensate.
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Pojawi sie teraz nowe okno, w ktérym znajdziemy tymczasowe wspoétrzedne dla naszych

stanowisk i btad zamkniecia ciggu oraz kat. Dodatkowo, pokazaty sie btedy wysokosci H oraz V w
nawigzaniu do dfugosci ciggu.

rTraverses | = |‘

ot o
Next Previous
Prirt Compensate ...

Stations

Survey Traverse

2 - 1

2 I

4

1

3 S 12

10 13

14 6

15

16

17

18 Y.

[V] Set Source [7] Set Destination

[(ok ] [ cancel | [ Hep.. |

& ]

Closure
© Least Squares () Planimetric L: 418694
B A eD: 0310°
" Proportional Distance ~ eH: 171351 *
_ © Both eV: 1/19457
! Proportional Increment: 3
. X 0162
Rotation and Homothety [ Fix compensated stations eY: 0264
eZ: 0022°
D Umiat [ Angular Error Share Ot ] eA 01600
Station HC X Coord. Y Coord. ZCoord. Vi W Vz
1 0.0000 300000.000 4D00000.000 100000 - -
5 181.5460 299589.327 4000035,783 100.746 - w
8 1427237 299562 808 4000056 .869 97.739 - -
11 136.3677 299896.409 4000099.547 94.348
12 230.9437 239509699 4000124.701 96.158
13 230.5097 299927418 4000158.795 §7.725
6 207.8055 300011.983 4000095.712 102278
Stations
{ Ficed ... ] l Mobile ... ] Hlipse Emor
Observations
[ Distances ... ] [ Azimuths .. ] [ Angles .. ] [ Verticals . ]
© Original Adjusted
(oK ] [(Concel | [ Heb. |

Prosze zaznaczyc opcje Least Squares i nacisngé Calculate. Wspdtrzedne tymczasowe zostang
teraz wyréwnane i na liscie pojawia sie odchytki. Pod listg pojawi sie informacja, ze test Chi? przeszedt
pomyslnie.
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Traverse _ -
Method of Calculation Fit Options Closure
© Least Squares ) Planimetric L. 418694
- eD: 0310°
- ) ® Ai
) Proportional Distance = eH: 171351
- © Bath &V: 1/19457
(©) Proportional Increments E
exX: -0.162
Rotation and Homothety [ Fx compenaated stations eY: 0264
eZ: 0022°
) Crandall ( Angular Error Share Out | eA-0.1600
Station HC X Coord. Y Coord. ZCoord. Vi W Vz
1 0.0000 300000.000 4000000.000 100.000 - - -
5 1815357 299989.317 4000035.758 100746  -0.010 0.024 0.000
8 142.7250 299962.774 4000056.842 97.740 0034 0.027 0.000
1 136.3744 299896.356 4000099.534 94348  -0.053 £0.013 0.000
12 2309731 299909622 4000124636 9158 0077 D064 0.001
13 2305287 299927.325 4000158 664 97.743  -0.093 0.131 0.018
6 207.7878 300011.800 4000095494 102279 0183 0218 0.001
Test Chi2: Passed
Stations
[ Fored ] Mobile ] Elipse Error ]
Observations
[ Distances il f Azimuths J & Anges .. " Vetticals .. ]
© Original () Adiusted
CoK]) [(Cmea] [Hb-]

Nacisnijmy Distances. W nowym oknie pojawig sie nam odlegtosci pomierzone i obliczone oraz
odchytki po wyréwnaniu. W ostatniej kolumnie jest wynik testu Baarda, ktdry pokazuje, czy mozna
polegaé na wprowadzonych danych.

firmm

Target  Observed Std. Dev.  Calculated

37.337 0.0030 37.340
37344 0.0030 37.340
33875 0.0030 33.880
33.886 0.0030 33.880
78.941 0.0030 78932
78.922 0.0030 78.932
28.452 0.0030 28.449
28.446 0.0030 28.449
38412 0.0030 38423
38415 0.0030 38423
105.453 0.0030 105.502
105.511 0.0030 105.502
96.176 0.0030 96.459
96.178 0.0030 96.459

Teraz nacisnijmy Print i zostawmy wszystkie opcje jak byty, po czym nacisnijmy OK.
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rCompemationReport LEJ‘
 ——
Stations
Observations [V Fixed
[V Distances i
] As [V Mobile
V] Verticals Resuts I
,_ [) Adusted Coordriates !
[¥] Original |
[ Adusted [] Deviations
[V] Elipse Exor
I [ ok | [ Cancel | [ Hep.. | ||J

W nastepnym oknie wskazmy opcje File w sekcji Destination i wigczmy opcje Open Editor.
Nacisnijmy OK i zapiszmy plik pod nazwg DOLMENES.PRN.

Compensation Report

e | ]
[V] Number Pages Frst Page
Destination Prirter

-m Aficio M 300 PCL E

@ File
) HTML
©) MS Word 8 Sepimos -

E (V| Open edtor
) M5 Excel . A

Drawing
sy
| Dont show this dialogue bax again, unless O key is pressed

(Cok ] [ Camcel | [ Hep. |

Powinien otworzy¢ sie edytor tekstowy, w ktorym zobaczymy raport z wyréwnywania ciggu
poligonowego.
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| Archivo Edicion  Formato  Ver Ayuda

Compensation Report
25/06/2014
method of calculation: Least Squares Adjustment

calculation in Plane Coordinates

Corrections Used

- Sphericity and rRefraction
- Reduction to Horizon
- Reduction to Sea Level

Fixed stations

Z Coord. Scale

4000035.758

4000056. 842

4000099, 534
4000124.636

4000158, 664 .
4000095.494  102.279

closing Errors

Zamknijmy edytor tekstu i zatwierdZzmy okno obliczania ciggu poligonowego. Przejdzmy do
Surveying -> Stations Calculation. Zaznaczmy stanowisko nr 5. Prosze zobaczy¢, ze podobnie jak przy
poprzednich wspétrzednych, te obliczone za pomocg ciggu poligonowego zostaty teraz zawarte na
liscie razem z btedami odlegtosci i wspétrzednych w odpowiednich miejscach.

Instrument Setups

1.570 1815357 562-582

il >

[ Instrument Setups...

wmﬂmihww

Points
| Coominates.. | |  Observations..

Coordinates Calculated

Observation Station X Coord. Y Coord. ZCoord. Observations

1 299989.327 4000035.783 100.746 Double Observation
8 299989.327 4000035.783 100.746 Double Observation
293989.317 4000035.758 100.746 Compensation

eD: 0.027 eX: 0.010 eY: 0.025 eZ: 0.000
Average | | Delete | [ Delete Al |

J L Coancel || Hep. |

Zestawienie plikow
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Po zakonczeniu pracy, w folderze z projektem powinny znalez¢ sie nastepujgce pliki.

Plik
Dolmenes.lev
Dolmenes.prn

Opis

Dane pomiarowe w formacie MDT
Raport z wyréwnania ciggu poligonowego

Plik z rozszerzeniem *.PRN mozna edytowac.
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éWiczenie 14 = Obliczenia geodezyjne

Celem niniejszego ¢wiczenia jest import punktéow do programu w systemie wspétrzednych
ED50/UTM30 i dokonanie ich transformacji do uktadu ETRS89/UTM30.

Na poczatku otwdrzmy plik carto ETRS89.dwg, ktéry mozna znalezé w katalogu C:\MDT7
Samples\Tutorial14.

Import punktéw

Prosze uruchomié polecenie Points -> Import (lub na wstgzce Points -> Creation -> Import).

Ustawiamy skale na 1:500 oraz naciskamy OK. Wybieramy plik ProyectoGPS_ED50.pun z katalogu
C:\MDT7 Samples\Tutorial14. Zostang teraz wyswietlone punkty z importu.
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Wyswietlmy wszystko na jednym ekranie. Widzimy, ze punkty sg przesuniete wzgledem
otworzonego rysunku.

Wizualizacja surowych danych

Plik z punktami jest zwigzany z plikiem o takiej samej nazwie, z rozszerzeniem *.GPS, ktory
zawiera informacje o surowych danych, ktére zostaty zapisane podczas pomiaru kazdego punktu. Te
dane zawierajg geograficzne wspétrzedne w uktadzie WGS-84, ilo$¢ satelitow, doktadnosé poziomg
oraz wysokosciowg i wskaznik PDOP.

WejdZmy w Points -> List Points (lub na wstazce Points -> Operations -> List) o naciskamy OK
w oknie Points Selection. Wszystkie dostepne punkty sg zaznaczone.
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Graphic <
Polyline (Area) <
Polyline (Longttudinal) <

Last Selection

| Delete Selection | | Invert Selection

[ Al
449 poirts selected of 449 available
(oK ] [ Cancel | [ Hebp.. ]

# Coordinate | Y Coordinate | Z Coordinate Code Descrption n C.Database |:
369096.344 4066531595 754.473

369096.626  4066532.008 754.072
369036.908 4066532421 753870
369097.1890  40B6532.834 753436
369097.471  4066533.248 753.253
369097.753 4066533661 753.081
369038.035  4066534.074 752995
369098.317  40B6534.487 752126
369098539 4066534900 752572
369098.881  4066535.313 752632
369099162  4066535.726 752348

fe e ta B RN ] T ot s e e e e T 23

m

[ Locate ] I Delete ]

Nacisnijmy prawym klawiszem myszy na nagtéwek kolumny Code i wybierzmy opcje Hide
Column. Podobnie postagpmy z kolumng Description in C. Database.
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X Coordinate | Y Coordinate | Z Coordinate  Cod

369096 344
369096.626
369096.908
369097.190
369097 471
369097.753
369038.035
369038317
369098.599
3639098 881
369099.162

AEASEO 4

1
2
3
4
5
E
7
g
9

4066531595
40686532008
4066532.421
4066532.834
4066533.248
4066533.661
4066534.074
4086534 487
4066534.500
4066535.313
40B6535.726

T tne e i R 2}

754 473
754.072
753.870
753.438
753.253

Hide column
Add fields...

Show hided columns

753.081
752.395
752126
752572
792,632
752348

Lot Wt

[Locate]

| Delete |

Aby dodad informacje GPS zwigzang z kazdym punktem, nacisnijmy prawym klawiszem myszy
na dowolnej kolumnie i wybierzmy opcje Add fields i wybierzmy opcje jak na rysunku ponizej.

Latitude (WGS-84)

Longtude (WG5-84)

Height [w/GS-84)

[] Date
[] Time

Horizontal Precision

i4] Vertical Precision

[] Antenna height
(] PDOP
[] Used Satelites

<|

L

| oK

][ Search drawing ”

Nacisnijmy OK, aby wyswietli¢ punkty z dodatkowymi informacjami w kolumnach.
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«

369096.344 4066531595 754.473
369096626 4066532008 754.072
369096.908 4066532421 753870
369097.190 4066532834 753436
369097.471 4066533248 753253
369097.753 4066533661 753.081
369098035 4066534074 752995
369098.317 4066534487 752126
369098599  4066534.900 752572
369098881 4066535313 752632
369099162 4066535726 752348

[ X Coordinate | Y Coordinate | Z Coordinate |atitude (WGS-8 ngtude (WGS-Edeight (WGS-B4arizontal Precisivertical Precisior ~

37" §'32617¢ 4°14'556771 754.473 0.016
37° 932390 4" 14'55613( 754.072 0012
37" §°32203¢ 4" 14'55.565¢ 753870 002
37° 831.977¢ 4°14'55507: 753436 oon
37° §°31.657% 4'14'55.412; 753253 0.015
37 8'31.348¢ 4" 14'55.308¢ 753.081 0013
37° 8 31.046¢ 4°14'55195€ 752.995 003
37° 8'30.7351 4°14'55052¢ 752126 0012
37° 830,539 4" 14'55.082¢ 752572 0014
37° 30,3460 4" 14'55.077¢ 752632 0.012
37° @°30.319¢ 4°14'55.0680 752.348 002

0018
0m3
0014
0014
0015
0014
0015
0013
0016
0013
0m3

[ Delete | [ Ed | [ Pt

[ Hee |

Transformacja uktadu wspotrzednych rysunku

Jak byto juz powiedziane wczes$niej, wczytane punkty sa w uktadzie ED50/UTM30. Aby wykonaé
transformacje punktow z uktadu WGS-84, ktérych odwzorowanie okresla uktad ED50, wykorzystano
plik z siatkg grid formatu NTv2 opublikowane przez Panstwowy Instytut Geograficzny danego kraju.

PrzejdZzmy do polecenia Coordinate Systems -> Convert Drawing

r ——
coneroenrs =

|

Source CRS

Projected CRS
Geodetic Datum Shift
Vettical CRS

Vertical Datum Shift
Target CRS

Projected CRS
Geodetic Datum Shift
Vertical CRS

Vertical Datum Shift

Element to convert
@ All Drawing

() Select Layers

() Select Entities
lgnore elevations

23030 : ED50 / UTM zone 30N
15932 : ED50to ETRS89 (12)

[7] Change layer of non-converted entities

Prefix

(]

(]

(]

[_LNOT CONVERTED_

(oK ] [ Cancel |

Nacisnijmy przycisk “...” znajdujacy sie w sekcji Source CRS. Aktywujmy opcje Area i wybierzmy

Europe - Spain.
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- Malta -
-~ Moldova

|- Monaco

- Montenegro

- Netherlands

- Norway

- Poland

+ Portugal

-~ Romania

- Russia

- San Marino

-~ Scotland

" Sarhia

- Shetland Islands
-~ Slovakia

- Slovenia

oS

m

[ ok | [ cancel | [ Help |

Na liscie Favourites, wybierzmy ED50-UTM30. Target CRS jest automatycznie uzupetniany
kodem 23030 i Geodetic Datum S. otrzymuje kod 15932. Jest to uktad wspdtrzednych uzywany do
pozyskiwania danych za pomocg GPS. Nacisnijmy OK.

Area EUROPE - Spain

Favorites |ED50-UTM 30

4
=

d. |

Projected CRS 23030: EDS0/UTM zone 30N
Geodetic Datum 5. 15932 : ED50to ETRS89(12)

Vertical CRS [None

CJ
| Ad
()
-
)

erical Datum S.

Dla ukfadu wtdrnego (Target CRS) nacisnijmy przycisk ,,...” i z Favourites wybierzmy ETRS89-
UTM30. Zostaty dodane kody 25830 oraz 1149 w odpowiednich miejscach. Naciskamy OK.
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[V Area EUROPE - Spain [:]
Favorites [ETRSBI-UTM 30 /[ Add. |
Projected CRS 25830 : ETRS89 / UTM zone 30N (]
GeodeticDatum S, 1149 ETRS83 o WGS 84 (1) E
Vertical CRS [None v] E
Vertical Datum S. E

[ OK ] [ Cancel ] [ Help ]

W sekcji Elements to Convert wybieramy Select layers | naciskamy przycisk “...” po prawej.
Wybieramy warstwe PUNTOS i naciskamy OK.

BASES
CIPRESES

DEFPOINTS
EJE
EXPLNADA_HORMI

FACHADA
JARDINES

MURETE
MUROSS
NORTE
PERLONG
ad

Naciskamy jeszcze raz OK. Rysunek powinien zosta¢ przetransformowany do uktadu, ktory
wybrali$my. Mozna teraz zauwazy¢, ze wspodfrzedne sg zgodne z rysunkiem.
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CWiczenie 15 = Zarzadzanie zdjeciami

W tym ¢wiczeniu bedziemy korzystali z diagramu mapowego, ktdry uzyjemy do stopniowego
pobierania danych z serwisu PNOA (National Aerial Ortophotography Plan, ktére zawiera cyfrowe
zobrazowania lotnicze catego terytorium Hiszpanii, jest to projekt obejmujgcy wspotprace i wzajemne
finansowanie pomiedzy urzedem centralnym a regionalnymi spotecznosciami). Pobrane zostang 4
obrazy potrzebne do pokrycia catego obszaru mapy i aby tego dokonac uzyjemy réznych narzedzi, aby
osiggnac efekt koncowy uzywajgc polecen: wstawiania, wklejania, georeferencji, ograniczania etc.
Wykorzystany zostanie klient WMS.

Podstawowe operacje na obrazach

Na poczatku otwdrzmy plik rysunku tutoriall5.dwg znajdujacy sie w folderze C:\MDT7
Samples\Tutorial15.

Wstawimy teraz nasze obrazy, ktére obejmujg nasz teren uzywajgc narzedzia Images -> Insert
WMS Map.
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Select the service to get the map and click Next'

Nombre | Direccion
Catastro  http:/love catastro.meh es/Cartografia\WMS/Servidorin/MS asg

»

SIGPAC  hitpi/lwms mapa. es/wms/wms aspx

*

< |

Coordinates
25830 : ETRS83/ UTM zone 30N [3

X Offset 0.000
¥ Offset 0000 " Bocariogd

() Visible Window

[ Net | [ Conctl | [ Help ]

Tak jak na rysunku powyzej, zaznaczamy serwer PNOA jako nasz serwer ze zdjeciami.
Wskazujemy opcje Designate window. Wybrac nalezy tez odpowiedni uktad wspétrzednych (zgodny z
uktadem, w ktérym zostata stworzona mapa) w sekcji Coordinates naciskamy przycisk ,,...” i wybieramy
uktad ETRS89-UTM30 dla Hiszpanii. Naciskamy Next. Bedziemy teraz poproszeni o wskazanie obszaru,
z ktérego pobierzemy obraz, wybierzmy jedng z cze$ci naszej mapy, zacznijmy od h1.

# Area EUROFE - Spain [.]
Favorites [ETRS8%-UTM 30 || Add. |
Projected CRS 25830 : ETRSB9 / UTM zone 30N [
GeodeticDatum S, 1149 - ETRS8 to WGS 84 (1) ™

 Cancel | [ Help |

[E2IM Ortofotos PNOA mé&ama actualidad

Image
Format image/ipeg P
[7] Create surface from SRTM data

1R existing imag

| Remove ex

[ DownloadMap | [  Cancel
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Pojawi sie nastepnie nowe okno, w ktérym bedziemy mogli wybrac¢ warstwy, ktére pobierzemy

z serwera. Wybierzmy tylko PNOA. Naciskamy teraz Download map. Efekt powinien by¢ podobny do
zaprezentowanego nize;j.

Powtdérzmy te same czynnosci dla pozostatych czesci naszej mapy, sciggajgc wszystkie jej
czesci.

TcpMDT ver. 7 — Podrecznik uzytkownika

Ustugi Informatyczne SZANSA Spoétka z o.0. z siedzibg w Bielsku-Biatej przy ul. Chryzantemowej 5, 43-300 Bielsko-Biata zarejestrowana w Sadzie Rejonowym w

Bielsku-Biatej, VIII Wydziat Gospodarczy Krajowego Rejestru Sadowego pod numerem KRS 0000536210, z kapitatem zaktadowym 50.000 ztotych. NIP
9372672769, REGON 360604756. Wszystkie prawa zastrzezone.



Gdy mamy juz wszystkie czesci naszej mapy, potgczymy teraz 4 obrazy w jeden. Uruchomimy

opcje Images -> Paste images. Wybieramy nasze obrazy, wpisujemy nazwe i wskazujemy lokalizacje
nowego pliku z catoscig.

Podobny efekt mozemy uzyskaé sciggajgc od razu obraz dla catej mapy.

Teraz przystgpimy do ograniczenia obszaru naszego obrazu. Aby tego dokona¢ narysujmy
polilinie stanowigca granice danego fragmentu mapy (u nas niech bedzie to osiedle w prawym gérnym
rogu mapy). Nastepnie wskazujemy polecenie Images -> Delimit Image. Wskazujemy teraz obraz, a
nastepnie granice obszaru i po naci$nieciu ENTER, podajemy nowg nazwe dla naszego pliku.
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Kalibracja rastrow

Kalibracja rastréow nastepuje w MDT nieco inaczej niz w typowych programach geodezyjnych,
lecz zasada jest ta sama. Najpierw musimy okresli¢ punkty na obrazie oraz na mapie, po czym musimy
je ze sobg pofaczyé. Nastepnie wybierzemy typ transformacji i wykonamy przeliczenie. Kalibracje
wykonamy dla pliku Tutorial15.jpg, ktérego znajdziemy w folderze C:\MDT7 Samples\Tutorial15. Obraz
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zawiera informacje katastralne. WejdZmy w Images -> Insert Images. Jako, ze obraz nie posiada
georeferencji, wskazujemy dowolny punkt na mapie jako punkt wstawienia oraz akceptujemy skale
domysing.

Aby wprowadzi¢ punkty dostosowania na obrazie, postuzmy sie ponizszym szkicem. Oczywiscie
w doktadnych pracach, nalezy wskazywaé punkty poprzez wspétrzedne, aby btedy transformacji byty
jak najmniejsze.

Aby wprowadzi¢ wspomniane punkty, przejdZzmy do Images -> Marks -> Create Marks i
wskazujemy odpowiednie punkty na obrazie. Odpowiadajgce punkty na mapie musza by¢ réwniez
wprowadzone, w przeciwnym wypadku nalezy uzy¢ opcji Points -> Insert i wskazac je.
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Po wprowadzeniu punktéw, wchodzimy w Images -> Marks -> Link from marks to points.
Program poprosi nas o wskazanie punktu dostosowania naobrazie oraz odpowiadajgcego mu punktu
na mapie. Pojawig sie przy tym zéfte linie taczace oba punkty.

Teraz nalezy uruchomi¢ polecenie Images -> Geo-Reference Image. Wskazujemy nasz obraz
do transformacji i pojawi sie nam nowe okno, w ktérym mozemy wybraé typ transformacji, przejrzec
punkty wtgczone do niej oraz sprawdzi¢ parametry. Pamietajmy, ze, aby wykona¢ transformacje
Helmerta musimy wskazaé¢ co najmniej 2 punkty dostosowania, a dla metody afinicznej 3 punkty
(zawsze warto mie¢ tych punktdw wiecej, aby mozliwe byto wyliczenie charakterystyk
doktadnosciowych transformacji). Wybierzmy metode afiniczna.

- .
Geo-Reference Image o

Image selected

Name Ejemplo 15 =
Links

Source Destination X Diff Y Diff

v 4 4 0.185 0.133

43 3 -0.100 0.072

v 2 2 -0.263 0.189

71 1 0.179 0.129

“ m ]
Interpolation
Transformation Calaate

Helmert 2D @ Affine

Results

M.S.E: 0.235 Max. res:  -0.263

X0: 298274.893 YO: 4025695.024

X Scale: 0.812395 Y Scale: -0.809675

X Rotation: 0.000190 Y Rotation: 0.00076%

| Apply ok Cancel
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Zestawienie plikow

Po zakonczeniu pracy, w folderze z projektem powinnismy otrzymac nastepujgce pliki.

Plik Opis
Tutorial15.dwg Plik z rysunkiem
Tutorial15.jpg Plik zawierajgcy dane katastralne
Results\Tutorial15.jgw Georeferencja dla powyzszego pliku
Results\new.jpg Pofaczone 4 obrazy w jeden
Results\new.jgw Georeferencja dla powyzszego pliku
Results\new_1.jpg Efekt ograniczenia obrazu
Results\new_1.jgw Georeferencja dla powyzszego pliku
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